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Preface

1. Give us Feedback

If you find a typographical error, or know how this guide can be improved, we would love to hear

from you. Submit a report in JIRA against eXo Content. The following link will take you to bug report

for eXo Content http://jira.exoplatform.org [http://jira.exoplatform.org/secure/Dashboard.jspa].

Select the document name and version number relevant to the document you found the error in

from the available lists then complete the description with as much detail as you can provide.

Be sure to give us your name so that you can receive full credit for reporting the issue.

http://jira.exoplatform.org/secure/Dashboard.jspa
http://jira.exoplatform.org/secure/Dashboard.jspa
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Overall Introduction

1.1. Overview

Beginning as an Open Source project in the year 2002, eXo is well-known as the industry's first

Java portlet container. With the aim of dominating the potential portal market through robust and

easy-to-use applications, eXo Project has succeeded in attracting consumers in the whole world.

eXo has actually opened the floodgates to various options in many markets, and customers have

been choosing eXo as the best method for their success.

The eXo Platform™ software is a powerful Open Source that corporates portal and content

management system. Users of the platform have a customized single point of access to the

company's information system and resources.

The foundation for eXo Platform 3.0 is eXo Core Services, a powerful set of REST-based

services for rapid website development, content management and gadget-based development.

eXo Extended Services are also a part of the eXo Platform 3.0, running on the top of eXo Core

Services to enable easy development of rich, user-centric web applications.

eXo Content is one of eXo Core services. It provides a set of services to extend portal-based

applications with Enterprise Content Management (ECM) capabilities. Document Management

System (DMS) features make it easy to catalog and organize enterprise content and with powerful

Web Content Management (WCM) services to quickly build dynamic, content-rich websites.

1.2. Why Use eXo Content

If you are looking for a powerful tool and strategies in managing website and content, eXo Content

is what you need. eXo Content is designed to provide webmasters who manage websites the

way to maintain, control, modify and reassemble the content of a web-page easily and effectively.

All components of your website can be organized, reconstructed easily, which helps you keep



Chapter 1. Overall Introduction

2

your website under the control. eXo Content really brings interesting experience for all users and

changes their way of thinking about website. The followings are key features of eXo Content:

Website Creation

Fast Setup:

Set up a new site in just a few clicks with an intuitive user interface and template features.

Navigate, Preview and Publish Content:

Navigate through page content in either a single content viewer or the list content display,

quickly preview page content or work on new content in draft mode and publish at anytime.

Templates:

Create websites from existing templates and themes, or create new templates with a

consistent look-and-feel across a single site.

In-Site Edition

The integrated rich text editor enables non-technical users to edit the pages they are in charge

of in an intuitive way.

Web Content Organization

Web-Based Administration:

Use a web browser to manage sites remotely, no local administration software is required.

Manage Multiple Websites:

Manage and control every site in one place.

Media Library:

Upload media to the library, publish, reuse and update all available media content across

multiple websites.

Content Search:

Search content and documents using categorization and tag features.

Broken Link Detection:

Know how many broken links are present and how many are functional with ease.

Versioning and Rollback:

Easily rollback a website's content with automatic versioning.

SEO and Friendly URLs:

Search Engine Optimization (SEO) is simplified for editing meta tags and more. Content has

its own specific URL for easier bookmarking and improved SEO.

Configuration for Deployment on Web Farms:

Advanced deployment rule for scalable, three-tier web application architecture with partitioned

replicated deployment.
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Capture and Manage Documents

Kofax Plugin:

Collect paper documents, forms, invoices and other unstructured documents and convert into

accurate and retrievable information, stored in the eXo JCR.

Access Control List:

Access Control List: Validate the current session's permissions to add nodes, set properties,

remove or retrieve items. Define actions to launch the next step in a process, or to invoke

any "coded" action required.

Workflow:

Specify processes for document collaboration and validation.

Record Management:

Track the status of content completion and control document storage life-cycles.

Store and Access Documents

JCR:

eXo JCR allows applications to access or manage files independent of their location, and also

provides advanced features such as unified access control, versioning, indexing and more.

Automatic Backup:

Define and automate tasks to save documents as required.

Web Interface:

Access documents in an intuitive and user-friendly web interface.

Microsoft and OpenOffice Plug-ins:

Microsoft and OpenOffice plug-ins give users the freedom to work on documents in their

preferred document editing program.

And More...  eXo Content also provides other powerful tools to manage an build content-rich

websites such as CSS, Java Script and RSS support, advanced document management tool,

collaboration tools, etc. All features is to meet your requirements for the purpose of easy site

management, cost reduction in managing multiple sites in only one place.

1.3. About This Document

The intended reader of this user guide are users using eXo Content. This guide will explain all the

basic and advanced features that eXo Content provides in managing websites and site content.

It gives in-depth examples and easy explanations of the technology that allows the webmasters

to create and manage a very fast and powerful website.

With this guide you will:
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• learn the basic terminologies used in eXo Content.

• know how to create, manage and publish Site content.

• know how to manage Web pages, set up a website, etc.

In this guide, we will use the following accounts (username/ password) throughout the guide:

• root/ gtn: This account is for users as Administrators who have the highest right on the platform.

• mary/ gtn: This account is for a publisher who can write content but also can create new pages

or edit them in the current site.

1.4. References and Related Sources

Information

• eXo Home Page [http://www.exoplatform.com/]

• eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/]

Support

• Forums [http://forums.exoplatform.org/]

• FAQs [http://faq.exoplatform.org/index.html]

Downloads

• eXo Content [http://www.exoplatform.com/company/public/website/platform/exo-core-services/

exo-content]

• eXo Development Tools [http://www.exoplatform.com/company/public/website/platform/exo-

core-services/exo-development-tools]

• Gatein Portal Framework [http://www.exoplatform.com/company/en/platform/exo-core-

services/gatein-portal-framework]

• eXo Collaboration [http://www.exoplatform.com/company/public/website/platform/exo-

extended-services/exo-collaboration]

• eXo Knowledge [http://www.exoplatform.com/company/public/website/platform/exo-extended-

services/exo-knowledge]

• eXo Social [http://www.exoplatform.com/company/public/website/platform/exo-extended-

services/exo-social]

http://www.exoplatform.com/
http://www.exoplatform.com/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://forums.exoplatform.org/
http://forums.exoplatform.org/
http://faq.exoplatform.org/index.html
http://faq.exoplatform.org/index.html
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/en/platform/exo-core-services/gatein-portal-framework
http://www.exoplatform.com/company/en/platform/exo-core-services/gatein-portal-framework
http://www.exoplatform.com/company/en/platform/exo-core-services/gatein-portal-framework
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
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Resource Center

• Video demos, tutorials, webinar archives, features and benefits tables and more [http://

www.exoplatform.com/company/public/website/resource-center]

http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
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Product Introduction

2.1. eXo Content

eXo Content is the technologies used to Capture, Manage, Store, Preserve, and Deliver

content and documents. It especially concerns content imported into or generated from within an

organization in the course of its operation, and includes the control of access to this content from

outside the organization's processes.

The eXo Content users can manage both structured and unstructured content, so that an

organization, such as a business or a governmental agency, can more effectively meet business

goals (increasing the profits or improving the organizational process with efficient use of budgets),

serve its customers (as a competitive advantage, or to improve responsiveness), and protect

itself (against non-compliance, law-suits, uncoordinated departments or turnover within the

organization).

eXo Content improves your operational productivity and efficiency. It enables you to transform

unstructured content into structured content through the process of capturing, storing, managing,

preserving, publishing and backing up while securely distributing it. The eXo Content portlet gives

you a portal solution that can help you achieve these processes and leverage your business

content across all formats for competitive gain. It also provides an environment for employees to

share and collaborate on digital content and delivering a comprehensive unified solution with rich

functionalities. Every component of your website can be organized, reconstructed easily, which

helps you keep your website under control.

eXo Content consists of three parts:

Document Management System (DMS) - an extension of eXo Content is used to store, manage

and track electronic documents and electronic images and allows documents to be modified and

managed easily and conveniently by managing versions, properties, and more.

Workflow: is the way of looking at and controlling the processes presented in an organization

such as service provision or information processing, etc. It is an effective tool to use make certain

that the processes are effective with the purpose of better and more cost efficient organization.

Web Content Management (WCM): helps in maintaining, controlling, changing and reassembling

the content on a web-page. It also helps webmasters who handle all tasks needed to run a website,

including development, design, content publication and monitoring.

2.2. Site Content Structure

Creating a site is a quick process, but deciding what content to put in the site and how to organize

it will take a lot of time. Thus, to mange a site more easily and more effectively, a site always has

a specific structure as follows:
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The Site Content is stored in collaboration workspaces of Java Content Repository (JCR).

Details:

CSS

This file is used to define the presentation of your entire site, such as font, color, size and more.

Documents:

All documents, which are used in a site will be stored in this folder.

JS

A programming script used on the site. This file is used to make a web page more animate

and dynamic in terms of graphics and navigation.

Links:

This folder stores all links used in the site.

Media:

This folder includes three sub-folders:

Audios:

Store all sound files used in a site.

Images:

Store all images, pictures used in a site.

Videos:

Store all video files used in a site.

Web content:

This folder is used to store the documents which present main content (texts images,

hyperlinks, audios and videos) of the site.
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2.3. Web Content

2.3.1. Web Content

Web Content is the textual, visual or aural content that is encountered as part of the user

experience on a website. It may include other things such as texts, images, sounds, videos and

animations.

2.3.2. Web Content Structure

The Web content may include various elements. Thus, to create and manage the Web content

more effectively and dynamically, each Web Content also has a specific structure:

Main content:

It contains all key content such as: texts, images, links, tables, etc.

Illustration:

It contains an image that is used as an illustration for the content. Additionally, a summary

also can be added to come with this image.

default.css:

It contains CSS data which is used to present the web content such as: layout, font, color,

and more.

default.js:

It contains JS data which is used to make web content more animating and dynamic.

2.4. Terminologies

2.4.1. Repository

A repository is a place where content is stored and maintained. The content repository is:

• A place where content is stored.

• A place where digital data are stored.

• Accessible to the user without having to travel across a network.

2.4.2. Workspace

A content repository is composed of a number of workspaces. Workspace is a term used by

several software vendors for applications that allow users to exchange and organize files over the

Internet. In our case, the content repository consists of more than one workspace. The “repository”

repository contains multiple workspaces, including : system, backup and collaboration workspace.
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System workspace:

is used to reserve “system folders”.

Backup workspace:

The backup process depends on the published content timestamps, each published document

has a duration for which it can be published and when it exceeds the timestamps, it will be

automatically archived to the backup database. This workspace is mostly used when using

the Workflow based content publication life-cycle.

Collaboration workspace:

Allows users to validate and manage documents. This is the central place to store and edit

content and media.

2.4.3. Drive

A drive can be understood as a shortcut in the content repository. It enables administrators to limit

visibility of each workspace for groups of users. It's also a simple way to hide the complexity of

the content storage by showing only the structure that makes sense for Business users.

More specifically, a drive consists of:

• a configured path where the user will start when browsing the drive.

• a set of allowed views that, for example, will allow to limit the available actions (such as the

edition or creation of content while being in the drive).

• a set of permissions to limit the access (and view) of the drive to a limited number of people.

• a set of options to describe the behavior of the drive when users browse it.

2.4.4. Node

A node is an abstract basic unit used to build linked data structures, such as linked lists and trees,

and computer-based representation of graphs. Nodes contain data and/or links to other nodes.

Links between nodes are often implemented by pointers or references.

A node can be defined as a logical placeholder for data. It is a memory block which contains

some data units, and optionally a reference to some other data, which may be another node that

contains other data. By linking one node with other interlinked nodes, very large and complex data

structure can be formed.

2.4.5. Version

Versioning means that at any given time the node's state can be saved for possible future recovery

and the action of saving called 'checking in'. A workspace may contain both versionable and non-

versionable nodes. A node is versionable if it has been assigned a mixin type mixin:versionable;

otherwise, it is a non-versionable node. A version exists as a part of a version history graph that

describes the predecessor/successor relations among versions of a particular versionable node.
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Software versioning is the process of assigning either unique version names or unique version

numbers to unique states of computer software. Within a given version number category (major,

minor), these numbers are generally assigned by increasing order and correspond to new

developments in the software. At a fine-grained level, revision control is often used for keeping

track of incrementally different versions of electronic information, whether or not this information

is actually computer software.

2.4.6. WebDAV

WebDAV stands for Web-based Distributed Authoring and Versioning. It is a set of extensions

to the Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage

files on remote World Wide Web servers.

The protocol was to make the Web a readable and writable medium. It provides functionality to

create, change and move documents on a remote server (typically a web server or "web share").

This is useful for, among other things, authoring the documents which a web server serves, but

can also be used for general web-based file storage that can be accessed from anywhere.

2.4.7. Podcast

A podcast is an audio file that you can download and listen to on your computer or a portable

MP3 player such as an iPod. The word itself comes from the combination of two other words:

iPod and broadcast.

2.4.8. File Plan

The file plan is the primary records management planning document. Although file plans can differ

across organizations, their typical functions are to:

• Describe the kinds of items the organization acknowledges to be records.
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• Describe what broader category of records that the items belong to.

• Indicate where records are stored.

• Describe retention periods for records.

• Delineate who is responsible for managing the various types of records.

2.4.9. Symlink

Symlink is a special file containing a reference to document or folder. By using symlinks, you can

easily access specific nodes (target) that symlinks point to. In Content Explorer, a symlink has a

small chain symbol next to its icon:
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Get Started

3.1. Account

3.1.1. Register an account

To register a new account on the portal, do as follows:

Procedure 3.1.

1. Go to the portal by inputting the URL in the address bar (e.g: http://localhost:8080/portal/

public/classic).

The anonymous homepage will appear:

2. Click the Register link on the top of the site, the Register form will be displayed:

http://localhost:8080/portal/public/classic
http://localhost:8080/portal/public/classic
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(*) required

The Account Setting information includes:

Table 3.1.

Field Information

User Name The user name that is used to login into the

system. It must be unique. The user name

must be started with a character.

Password The security characters are used to login. It

must have at least 6 characters.

Confirm Password The re-typed password above. The

password in Password field and this field

must be the same.

First Name Your first name

Last Name Your last name

Email Address Your email address. It must have a right

format: username@abc.com

3. Input values for the fields in this form.

4.
Click the  icon to search and check if the inputted user name is available or not.

5. Input values in the fields of User Profile tab, including: Profile information, Home information

and Business information.



Sign In

15

6. Click Save to register a new account, or Reset to renew all inputted values. There is an

alert message, and you cannot add a new account successfully if at least one of these cases

occurs:

• User name is existing or invalid.

• Password has less than 6 characters.

• Password and Confirm Password are not the same.

• Email Address has invalid format.

• Required fields are empty.

After adding a new account, contact with the administrator to get the confirmation.

Email

You should enter your email address exactly because when you forget username

or password, you can recover it by using this email address.

3.1.2. Sign In

This function enables you to go into eXo Platform in the private mode.
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Procedure 3.2. Sign in

1. Go to the eXo Platform in the public mode by inputting the URL in the address bar (e.g: http://

localhost:8080//portal/public/classic/).

2. Click the Login link at the top of the home page. The Sign in form will appear:

3. Input your registered User name and Password.

4. Click Sign in to accept, or Discard to exit from the Sign in form.

Table 3.2. Options

Option Information

User name To input the registered username.

Password To input the password of your username.

Forgot your User Name/Password To retrieve the forgotten user name or

password when you forget.

Sign in To sign into the eXo Portal with the inputted

user name and password.

Discard To close the Sign In form without any

changes.

If the User Name does not exist or the inputted User name/Password is invalid, there will be

an alert message that requires users to input right values. The page will be redirected to the

private security checking mode.

To login again, enter User Name and Password again.

After signing in, you will be redirected to the authenticated homepage like the illustration.

http://localhost:8080//portal/public/classic/
http://localhost:8080//portal/public/classic/
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3.1.3. Sign Out

The function lets you get back to the anonymous portal. It ends your current portal session.

To sign out, click the Logout link on the right access banner:

or click Start Logo → Sign Out from the menu:

3.1.4. Retrieve user name/password

If you forget your account or password, you can recover them by doing as follows:

Procedure 3.3.

1. Click the link Forgot your User Name/Password? in the Sign in form.

This form offers two options:
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Forgot my password:

If you forgot your password, you need to select this option.

Forgot my username:

If you forgot your username, you need to select this option.

2. Select one of these two options in this form. The selected option will be shown:

If the Forgot my password option is selected the form to recover the password appears:

If the Forgot my username option is selected, the form to recover the user name appears:

3. Enter your username or email in the corresponding form.

4. Click Send to send the inputted values.
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Once information has been sent, you will receive an email with your User name/ Password

in your email address that you registered.

• If you forget User Name: when a username is retrieved, your old username is restored and

can be reused and a new password is also sent to your email with the old username.

• If you forget old password: a new password will be set (as temporary, then you will be

directed to change the password for the next time you sign in).

3.1.5. Change account information

The function enables you change your account information, such as your profile and password.

Procedure 3.4.

• The first thing to do is to directly click your own account name.

The Account Profiles tab will appear:

Procedure 3.5. To Change Account Profiles

1. Select the Account Profiles tab.
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This tab displays your current basic information.

2. Change your First Name, Last Name and Email. You cannot change your User Name.

3. Click Save to accept changes.

Procedure 3.6. To change your Password

1. Select the Change Password tab.

2. Input your current password to identify that you are the owner of this account.

3. Input your new password, it must have at least 6 characters.

4. Input your password again in the Confirm New Password field.

5. Click Save to accept changes.

3.2. Change the display language

The priority order of display language is shown to the following order:

1. User's language

2. Browser's language

3. Portal 's language.
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Thus, to display your preferred language, you should pay attention to this order to change the

language type appropriately.

1. Move the mouse over Start Logo → Change Language on the top left corner of the portal:

The Interface Language Setting form appears:

2. Select the another language in the list. The currently selected language will be marked with

the  icon.

3. Click Apply to change the display language temporarily, and wait few seconds to take effect,

or click Cancel to quit without any changes.

3.3. Change the skin of the current site

The eXo skins are attractive user interface styles for displaying a portal. Each skin has its own

characteristics with different backgrounds, icons, and more. Changing the skin of the current site

can make use of the portal easier and more effective.

Procedure 3.7.

1. Move the cursor to eXo > Change Skin item in the drop-down menu:
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The Skin Setting form appears.

2. Select the skin you want by clicking its name.

3. Click Apply and wait a few seconds to take affect.

These actions can be done by users who have the right to use the Administration bar with a

personal preferences menu.
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Basic Actions
These actions are for all registered users after they have logged in the accounts.

4.1. Print content

Users can easily print any content in a site by following these steps:

1. Click Read more to read all the content of a document or of an article in a site.

2. Click the Print button. The Print Preview page will be displayed on another tab.

3. Click Print to print the content of this page, or Close to close this tab without printing.

4.2. Manage a site

4.2.1. Create a new site

Note

In eXo Platform, only Administrators have right to create a new site.

This function enables you to create a site (portal) to meet your own needs.

Do the following:

1. Click Site on the Administration bar. A list of existing portals is listed.
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2. Click the Add New Portal button to open the form to add a new portal.

In the Portal Setting  tab, set some properties for this site, including the portal name, locale

and skin.

Table 4.1. Details:

Field Information

Portal name The name of the portal. This field is required

and must be unique. Only alphabet, numbers

and underscore characters are allowed. The

Portal name must be at least 3 characters.

Locale The interface language of the portal. This

field is required.

Skin The skin of the portal.

3. Select the Properties tab to keep session alive.

The Keep session alive option means keeping the working session for a long time to avoid

the working time out. There are 3 options:

never:

The session never happens even if the application requests.
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on demand:

The session starts to be used as soon as the application requests.

always:

The session is always enabled.

4. Select the Permission Setting tab to set access and edit permission for this portal.

The Permission Setting tab includes two sub-tabs: Access Permission Setting and Edit

Permission Setting.

Access Permission Setting tab

By default, the access permission list of the portal is empty:
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Check the  Make it public  check box to assign the access permission to everyone, or

click the Add Permission  button to assign the access permission to a specific group

which is selected from the  Select Permissions form (By selecting a group on the left

and a corresponding membership on the right):

After selecting groups, the access permission list is displayed:

In which, the  icon is to remove its corresponding group from the Access Permission

list.

Edit Permission Setting

By default, it is also empty and you have to assign the edit permission to a specific group.
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You can assign the edit permission to a group with a specific membership by clicking the

Select Permission  button in the Edit Permission Setting tab to open the Permission

Selector form. Select a group in the left pane and a corresponding membership in the

right pane.

The asterisk (*) from the Select a Membership pane means that you assign the right for

everyone in the selected group from left pane.

After selecting a group, the Current Permission will be displayed with detailed information:
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The edit permission is assigned for only one group at one time. You can click the Delete

Permission button to remove the current edit permission of the selected group or re–

assign the edit permission to another group by clicking the Select Permission button again

and select another group.

5. Click Save to create a new portal.

After creating a new site, a list of the existing sites will be displayed on the screen. This new site

will be added to the exiting site list in Site  on the Administration bar and to a drive list that

includes all its default files.

To see it in the drive list, click Group > Content Explorer on the Administration bar.
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For example, after creating a portal named 'eXo', there is a drive named 'eXo' in Content Explorer:

4.2.2. Edit a site

This function enables you to edit a site, including the configuration (setting, permission), the

navigation and the layout components of the site.

There are two ways to approach a site that you want to edit:

• The first way: Edit the site that you are browsing by accessing to Site Editor.

• The second way: Edit the site by accessing to Sites.

4.2.2.1. By accessing to Site Editor

Directly edit the site you are browsing by going to Site Editor > Edit Layout

The form to edit the site appears.
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Details:

Table 4.2.

Indicator Meaning

Site's config: allows editing the site's

configuration.

Switch View Mode: shows how the current

layout looks like with real content.

Finish: allows saving all changes and

escaping the Edit page

Abort: allows canceling all changes that have

not been saved and quitting the Edit page

With this way, you can only edit the layout and the configuration of site.

Edit layout.  Editing the layout means editing a banner, a navigation bar, a breadcrumb bar,

a homepage and a footer of a website. You can also add more portlets to the site by dragging

and dropping from the Applications tab of the Edit Inline Composer form to the main pane.

Moreover, you can move a portlet from a location to another location.
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Editing the banner portlet is similar to editing the Sign-in portlet and the footer portlet so in this

guide, we only show how to edit the banner of the site as an example of editing the layout.

Edit Banner

1.

Show the form to edit a banner by clicking the  icon of the banner portlet in the Edit

Portal form like the illustration below.

A form to edit the current banner will appear.
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2. Select Edit Mode tab:

Content Selection: Select the path of the content that you want to show by clicking .

Display Settings:

• Show Title: Specify whether the title of the content is displayed or not.

• Show Date: Specify whether the date of the content publication is displayed or not.

• Show Option Bar:Show or hide the Option bar used to show the print link.

Print Setting:

• Show in page: Choose a page for the print review.

• with: Parameters contains the content path.

Advanced: The content should enable “dynamic navigation” that interprets the URL and

shows content.

Note

Click the  icon to see more explanation for each section.

3. Select the Portlet Setting tab:
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Details:

Table 4.3.

Display name The display name of the portlet. You cannot

change it.

Portlet Title The title of the portlet. You can change it.

Width The width of the portlet.

Height The height of the portlet.

Show info bar Tick the check box if you want to show the

info bar of the portlet.

Show Portlet mode Tick the check box if you want to show the

portlet mode.

Show window state Tick the check box if you want to show the

window state.

Description Enter a description about the portlet.

4. Select Icon tab: Select an icon for the portlet by clicking it.

5. Select Decoration Theme tab: Select a decoration theme for the portlet.

6. Select Access Permission tab:

By default, all users can access the portlet:
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However, you can edit the access permission by unticking the checkbox > click Add

Permission:

The ListPermissionSelector form appears. Select a group in the left pane and a membership

in the right pane.

Note

The asterisk (*) in the right pane means all members in the group.

7. Click Save and Close to commit.

8. Click the disk icon to quit the form to edit the current site.

Edit Configuration.  To edit the configuration ( including language, skin and permissions) of the

site, click the  button to open the same form as the form to add a new portal.

Do the same steps as in Section 4.2.1, “Create a new site”.
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Note

You cannot change the name of the site.

4.2.2.2. By accessing to Site

This approach way enables you to edit the layout, configuration and navigation bar of a site by

going to Sites > select the site in the existing site list.

Edit Layout.  Do the following to edit the layout of an existing site.

1. Click Site --> Edit Layout to open a form to edit the site layout.

2. Do the same steps as the part Edit layout of the current site.

Edit Navigation.  Do the following to edit the navigation of a site.

1. Click Site --> Edit Navigation to open the Navigation Management form.
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2. Click Add Node to open the ADD/EDIT PAGE NODE form. (For more details, refer to the

Section 5.3.1, Add a new node, GateIn User Guide 3.1.)

3. In the Page Node Setting tab, enter a name for the node. It is required.

Details:

Table 4.4.

Uri: The node's identification. The Uri is

automatically created once a new node has

been created.
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Label: The node's display name on the screen. This

field may be changed and its length must be

between 3 and 60 characters.

Visible: This checkbox allows the page and its node

to be shown or hidden on the navigation bar,

the page navigation bar and the sitemap.

See above for more details.

Publication date & time: This option allows this node to be published

for a period of time. Two fields, including

'Start Publication Date' and 'End Publication

Date' only display when this option is

checked.

Start Publication Date: The start date and time to publish the node.

End Publication Date: The end date and time to publish the node.

4. Select the Page Selector tab:

Details:

Table 4.5.

Page Id: The identification string of the page. It is

created automatically when the page is

created.

Name: The selected page's name.

Title: The selected page's title.

Clear Page: To remove the input page information in the

fields

Create Page: To create a new page with the input name

and the title.
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Search and Select Page: To search and select an existing page.

• Enter a title for the page.

• Click Create Page to create a new page or Search and Select Page to select an existing

page for the node.

5. Select the Icon tab to choose an icon for the node. It is not required.

6. Click Save to create a node for the navigation.

Note

You can edit/delete a node, edit a node's page, copy/cut a node and more by right-

clicking the node in the form Navigation Management form.

Edit Configuration.  The portal's configuration including language, skin and permissions can

be edited by doing the following:

1. Click Site --> Edit Portal's Config to open the same form as the form to create a site.

2. Do the same steps as in Section 4.2.1, “Create a new site”.

4.2.3. Switch between sites

This function is used to change the current website by another one.

• Just select a site in the site list that appears when you move the cursor to Sites on the

Administration bar:

Your current site will be switched to the selected site, and you will see all the child pages that

displays on the Navigation bar of the selected site.
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4.2.4. Delete a site

This function is used to delete a portal (site) from the portal list.

1. Show a portal list by clicking Site on the Administration bar:

2.

Click the  button in the row of the portal that you want to delete.

3. Click OK in the confirmation message to accept deleting.

Note

You cannot delete the Classic site by default.

4.2.5. View a site

In eXo Platform, we use the 'Website' term which is equivalent to the 'Portal' term. So, viewing a

portal means viewing a website. You can select the site that you want to view by selecting the site

name in the drop-down menu on the Administration bar:
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The main screen of the site will appear like the illustration below:

Administration bar which contains administration functions related to portals (websites).

Banner which contains slogan, logo, icon used in the website.

Navigation bar which helps users to visualize the structure of the website and provide quick

links to different pages.

Home page which is the main page of the website. This is the default page that is displayed

first when you visit the website.

Footer of the website. It can be texts, or image that is displayed at the bottom of the website.

It provides information about author/institutional sponsor, revision date, copyright and more.

4.2.6. Search content in a site

The Search function allows you to quickly search for any content in the system with a keyword

from the front page, even if you do not log in. However, the number of the search results displayed

depends on your role.

For example, if you do not log in, you only see the search results that are published.



Search content in a site

41

4.2.6.1. How to search for content?

1. Enter a keyword into the search box and press Enter.

The search results matching with your keyword are displayed in the search page:

In case of no search results matching the keyword, the search page is displayed as below:
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Details of the Search form

Table 4.6.

Field Details

in Content Search in all content containing the keyword.

in Pages You can search in all portals or in a specific

portal. The returned results are the pages

which contain the keyword in their name, title

or their SEO data [175] (description, and

keyword).

2. In the Search form, you can enter another keyword and set the the search scale.

3. Press Enter, or click Search to start searching.

4.2.6.2. Edit the Search portlet

Editing the Search portlet allows you to change the display of search results.

1. Open the Search page as Section 4.2.6.1, “How to search for content?”.

2. Open the Edit Mode of the Search portlet by following one of two ways:

• The first way

Hover your cursor over Edit --> Content on the Administration bar, and then click the

 icon:

• The second way

Hover your cursor over Edit --> Page --> Layout on the Administration bar. The Page

Editor will be displayed.

•
Hover the mouse pointer over the SearchResult portlet and click  to edit the portlet.
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The Edit Mode of the Search portlet appears.

Details:

Table 4.7.

Field Details

Items per Page The number of search results displayed in

each page.

Page Mode The way to display the search results. There

are 3 options:

• None: Only the first page of search results

is displayed in the search page.

• More: When you click the Search button,

the first page of search result is displayed.

The difference from the None mode is
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Field Details

that, there is a More button allowing

you to see more search results. When

clicking this button, new search results

are appended to the current search result

page like Twitter or Facebook behavior.

• Pagination: In this mode, the search

results are divided into many pages (for

example, 1, 2, 3 and Next). You can

navigate to another page by clicking the

page number or Next in the bottom of the

Search portlet to view more results.

Search Form Template The template of the Search form.

Search Result Template The template for displaying the search

results.

Search Page Layout Template The layout of the Search portlet.

Base Path The page where you can see the content of

a search result.

3. Edit your desired portlet and click Save to accept your changes.

4.3. Contribute content

4.3.1. Edit mode

When you access a site, by default, the site content is in the published mode and you cannot

edit them.

However, each site in eXo Platform has the Edit mode which enables you to edit all content of the

current site. When hovering your cursor over content, you can see the Edit icon which enables you

to quickly edit this content. You can take advantage of this feature to submit content to a page.

To turn on the Edit mode, hover your cursor over Edit on the Administration bar, then select

Content from the drop-down menu.

For Single Content Viewer (SCV), you can see the current state of the content, the Edit Content

icon and Preferences icon.
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For Content List Viewer (CLV), you can see the current state of the content, the Edit Content icon,

the Preferences icon, the Add Content icon and the Manage Content icon.

4.3.2. InContext Editing

By using the InContext Editing feature, the process of editing a page becomes more intuitive.

This feature allows you to edit content "in context" without using the WYSIWYG editor, and the

new content will automatically override old one.

To use InContext Editing, turn on the Edit Mode.

4.3.2.1. Add content

Adding new content by using InContext Editing is enabled for the Content List Viewer (CLV).

1. Turn on the Edit Mode, then hover your cursor over the CLV to which you want to add new

content.

2. Click  on the CLV.
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You will be directed to the Sites Explorer with a list of content templates for you to select.

Details:

Table 4.8.

Field Description

Free layout web content This template is a free layout.

Picture on head layout web content The site's content is presented in two

spaces. One is for inserting an image and the

other for editing the site's content. The image

will be put at the head of a site.

Display the list of the content templates in the

List view.

Display the list of the content templates in the

Thumbnail view.

Cancel selecting the content template and

back to the previous page.

3. Click one template for your content. Each template has an Info bar on the top of the template.

Details:

Table 4.9.

Field Description

Change Content Type Select another content types.

Save Save the content without closing the content

form.

Save & Close Save the content and close the content form.

Close Close the content form without saving the

content.

Switch on/off the full-screen mode.
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4. Fill all the fields in the form. See the Add a document section to know how to create the

different content types.

5. Click Save or Save & Close to save the document.

Note

The folder, where a document is saved, is the path you have selected in the

Preferences section.

4.3.2.2. Edit content

You can edit any content on the homepage for SCV and CLV with InContext Editing. However,

for CLV, you only can edit each content in it.

1. Turn on the Edit mode by hovering your cursor over Edit on the Administration bar, then

select Content.

2. Hover your cursor over the content you want to edit, and click  at the right corner. You will

be directed to Sites Explorer with the document form for you to edit.

3. Make changes on the content, then click Save or Save & Close to accept your changes.

4. Click  to return to the site. In the Edit mode, your new content will be in the "Draft" state

with its visible modifications.
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5. Click  , or  on the Action bar to publish your edited content. Your content is now in

the "Published" state.

Note

You cannot see the edited content in the draft state when you turn off the Edit

mode.

4.3.2.3. Manage content

With InContext Editing, you can easily manage a Content List Viewer on the homepage. You

can add new content in the CLV, edit, delete an existing content or copy/cut/paste to another CLV

and take more actions in the right-click menu.

Add content in the CLV

1. Turn on the Edit mode.

2. Hover your cursor over the CLV which you want to manage on the homepage, and click  .

You will be directed to the Sites Explorer page.

3. Click  on the Action bar.

4. Do the same steps as in the Add Content section.

Do other actions

Right-click specific content in the CLV to open the drop-down menu. From here, you can do many

actions as mentioned in the Actions on folders and documents  section.

4.3.2.4. Preferences

Preferences enable you to edit content in the Single Content Viewer (SCV) and the Content List

Viewer (CLV), reset the display of the content in SCV and CLV and publish content.

Edit the Single Content Viewer
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1. Turn on the Edit mode.

2. Select  of a Single Content Viewer.

The Content Detail Preferences dialog appears.

Details:

Table 4.10.

Field Description

Content Selection Select the path of the content that you want

to show by clicking  .

Display Settings Configure the visibility of Title, Date and

Option bar.

• Show Title: Select this checkbox to

display the title of the content.

• Show Date: Select this checkbox to

display the date of the content publication.
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Field Description

• Show Option Bar: Select this checkbox

to display the Option bar which is used to

show the print link.

Print Settings • Show in Page: The content is shown in

the page.

• with: Parameters contain the content

path.

Advanced link: When clicking this link, the Advanced pane

will be shown with two parts.

• Dynamic Navigation: Allow you to get

a parameter to configure the portlet by

URL. It means that the URL containing the

content path can be dynamically changed.

• Disable: By default, if the property is

set as "Disable", the Advanced pane is

closed by default. It means the single

content will be opened by an URL

containing the Content Path.

• Enable: This portlet is configured with

the provided parameter ("content-id" by

default) and the content.

• By: This parameter is the key in the

URL to let SCV know which really is the

path in the current URL. It is editable

when the Contextual Content is set to

"Enable".

• Content Visibility: Allow you to use

a cache shared between users to get

content. If you want to get content,

which are displayed in CLV or SCV,

from one cache, select Restricted by

Authentication. If not, select Restricted

by User Roles.
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Note

Hover your cursor over  to see a quick help for each section.

3. Click  next to the Content Path to select another content. The Select Content dialog

appears.

4. Select a folder in the left pane, and its content in the right pane. The selected content will be

displayed in the Content Path field.

5. Tick the checkboxes, including Show Title, Show Date and Show Option Bar, if you want

to display the content title, the publication date and the print button like the illustration below.

i. In the Print Setting part, click  to open the UIPageselector dialog. You will see

Printviewer.

ii. Click the Print button. The content is opened in the print viewer page.

6. Click Save to save all your changes.

Edit the Content List Viewer

1. Turn on the Edit mode.

2. Select the Preferences icon of a Content List Viewer.
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The Content List Preferences dialog appears.

Details:
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Table 4.11.

Field Description

Content Selection Mode: This mode is to select web content for

the list viewer. There are two modes:

• By Folder: This mode allows you to select

a content folder in the Folder Path field.

• By Content: This mode allows you to

select by the content in a specific folder in

Folder Path field.

Folder Path: The path to a location of a

folder that contains the content.

Order by: Sort content in the List Viewer

by Title, Date Created or Date Modified in

ascending or descending order.

Display Settings Header: The title of all content that is listed

in the List Viewer.

Template: The template which is used to

view the content list.

Paginator: The template which is used to

view each content in the list.

Items per Page: The number of items which

will be displayed per page.

The following options which can be shown

or hidden by ticking or unticking checkboxes

respectively.

• Show Title: Title of each published web

content/document.

• Show Header: Header of each published

web content/document.

• Show Refresh: The Refresh button at the

left bottom of the page.

• Show Image: The illustration of each

published web content/document.
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Field Description

• Show Date: The created date of each

published web content/document.

• Show More Link: The Read more link to

read all the content of web content and/or

document.

• Show Summary: The summary of each

web content/document.

• Show Link: The link of web content/

document.

• Show RSS Link: The RSS link of all

content of web content/document.

Advanced link Dynamic Navigation

• Disable: The single content will be

opened by an URL containing the Content

Path.

• Enable: This portlet is configured with

the provided parameter (content-id by

default).

• By: This parameter is the key in the URL

to let CLV know which really is the path in

the current URL.

• Show in Page: The single content in

CLV will be shown in a selected page.

You can select any page but should take

one with a Content Detail Portlet. The

"Dynamic Navigation" is enabled in the

Content Detail Portlet that interprets the

URL and shows a single content.

• With: This parameter is the key in the URL

to let SCV know which really is the path in

the current URL.

Content Visibility: Allow you to use a cache

shared between users to get content. If you

want to get content, which are displayed

in CLV or SCV, from one cache, select



Inline Editing

55

Field Description

Restricted by Authentication. If not, select

Restricted by User Roles.

3. Browse the documents or web content of an available site by clicking  next to the Folder

Path field.

4. If you select the By Folder mode, select an available site on the left, then select a folder that

contains content (documents and/or web content) on the right by clicking the folder.

If you select the By Content mode, select an available folder from the left pane, all content

in this folder will be listed in the right pane. Click content on the right that you want to add to

the content list. There will be a message, informing that you have successfully added it to the

Content List. The selected content will be listed in the Content List.

5. Enter a header for the content list in the Header field if you want.

6. Select a template to display the content list in the template list.

7. Tick/Untick your desired options.

8. Click Save to accept your changes.

4.3.3. Inline Editing

The Inline Editing mode allows you to edit directly on the page without going to a separate one.

By using this mode, you can edit the text in the same location in such an intuitive and convenient

manner.

Do the Inline Editing

1. Turn on the Edit mode on the Administration bar.

2. Hover your cursor over the area you want to edit. The editable area will be highlighted.

3. Double-click the area until the Edit area is shown as below.

In case the hovered area is in the Rich Text format, the Edit area will be displayed with

the CKEditor [http://docs.cksource.com/CKEditor_3.x/Users_Guide] as below. (See more

information about CKEditor here.)

http://docs.cksource.com/CKEditor_3.x/Users_Guide
http://docs.cksource.com/CKEditor_3.x/Users_Guide
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4. Make changes on your selected area.

5. Click  to accept, or  to discard changes.

• After you have made changes on your content, it is only in the Draft state.

• Click  to publish the content. Now, your edited content is in the Published state.

4.3.4. CKEditor

When using CKEditor to write/edit a document, you can also:

• Insert a portal link to the document. [56]

• Insert a content link to the document. [57]

Insert a portal link

1. Click  to open the Insert Portal Link form.
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2. Enter the title of the portal in the Title field.

3. Enter the portal URL manually, or you can also click Get portal link to open a page containing

all the portals in the same server, then select one that you want.

4. Click Preview to view the portal.

5. Click Save to accept inserting the portal to the document.

Insert a content link

1. Click  to open a page.
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2. Click the plus before the document name, or click directly the document name in the left pane

to show the content in the right pane, or click  to upload a file from your local

device.

3. Click content that you want to insert to the document.

4.3.5. Publication process

After new content has been created, it is saved as draft and you can easily to publish it on your

site. The publication process consists of four steps:

Request for Approval --> Approval --> Stage --> Publish

In case you want to publish your content without having the "Approve" or "Publish" right, you first

need to send your request for approval.

In case you have the right to approve or publish content, you can yourself publish it with the Stage

step immediately.

• Request Approval: When new content is created, it must be approved before publishing by

clicking Request Approval on the Action bar of the Sites Explorer or clicking Pending in the

Manage Publication form.
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• Approve: To approve content, click Approve on the Action bar of the Sites Explorer, or

Approved in the Manage Publication.

• Stage: This step allows you to publish content in a period. After selecting the publication

schedule for the content, it will be automatically published as the schedule.

To publish your content just in a stage, click Stage. Then, click From/To to select the start and

end dates for publication from a mini-calendar.

To publish your content forever, you should not set time in the To field.

• Publish: Content will be published when you have completed the Stage step.

Note

You will see a list of draft content, pending content which are waiting for your

approval if you have the approval right, and content that will be published at the

bottom of the Sites Explorer. Click your desired content to review, approve or

publish.

4.4. Content inside categories

In eXo Platform, you can create new content in any folders or directly in a CLV with Incontext

Editing. However, to facilitate the content management, categories are usually used to sort and

organize documents that makes your desired searches more quickly. Also, creating content inside

a category helps you manage and publish them effectively.
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After creating a document, you should categorize it by adding it to a category. Otherwise,

documents should be created right in a category and links to those documents will be automatically

created in the category. In eXo Platform, categories are stored in JCR.

4.4.1. Create content inside a category

This section will show you how to create content in a category.

1. Hover your cursor over   --> Content --> Sites Explorer on the Administration bar.

For example, select the acme-category drive as the following illustration.

2. Click the New Content button to create new content. See the Add a document section to

know how to add new content. The new content is a Symlink. To view the content, simply

click the Symlink.
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4.5. Dynamic Navigation

Dynamic Navigation enables you to get a parameter to configure the portlet by URL. It means that

the URL containing the content path can be dynamically changed.

This section shows you how to use Dynamic Navigation in eXo Platform.

Do the following to access Dynamic Navigation:

Procedure 4.1. Access Dynamic Navigation

1. Turn on the Edit Mode > hover the mouse over SCV or CLV and select the Preferences icon.

If you select the Preferences icon of SCV, the Content Detail Preferences form displays.

If you select the Preferences icon of CLV, the Content List Preferences form displays.

2. Click the Advanced link in the Content Detail Preferences form/ the Content List Preferences

form.

The Dynamic Navigation will display.

Dynamic Navigation in SCV

Details:
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Table 4.12.

Contextual Content • Disable: It means the single content will be

opened by an URL containing the Content

Path.

• Enable: This portlet is configured with

the provided parameter (content-id by

default).

By This parameter is the key in the URL to let

SCV know which really is the path in the

current URL. It is editable when Contextual

Content is Enable.

For example, open single content with the Content Path "ACME Introduce". The URL of the

content is the following:

URL: ... /ecmdemo/private/acme/printviewer?content-id=/repository/collaboration/sites

content/live/acme/web content/site artifacts/Introduce&isPrint=true

Dynamic Navigation in CLV
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Details:

Table 4.13.

Contextual Folder • Disable: It means the single content will be

opened by an URL containing the Folder

Path (for CLV)

• Enable: It means the path of content list

(Folder Path in the Content Selection path)

can be dynamically changed by URL.

By This parameter is the key in the URL to let

CLV know which really is the path in the

current URL.

Show in page The single content in CLV will be shown in

a selected page. You can choose any page

but you should take one with a Content Detail

Portlet. The Content Detail Portlet should
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enable “dynamic navigation” that interprets

the URL and shows the single content.

With This parameter is the key in the URL to let

SCV know which really is the path in the

current URL.

4.6. Content Explorer

4.6.1. Access Sites Explorer

This page is used to manage all documents in different drives. This is really a flexible way

because you can do through Internet whenever and wherever. By default, anyone can access

Sites Explorer, but the ability to do actions on Sites Explorer depends on the role of each user.

• Hover your cursor over  on the Administration bar, then select Content --> Sites Explorer

from the drop-down menu.

A list of all drives organized in groups (Personal drives, Group drives and General drives)

in the Sites Explorer are displayed.
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Personal drives

This is the working space of a user. If you want to do in private, select the Private drive,

no one else can access or get your private resources. If you want to create resources

and share them with others, work in the Public drive.

Group drives

The working space of users of a specific group.

In the following example, the user "root" joins in three groups: "executive-board",

"administrators" and "users" so he has the right to access these groups' drives.

General drives

This is the working space for everyone but your access right in different drives depends

on your role. If you access as an administrator role, you can see all drives; otherwise,

you can see some drives only as a web contributor role.

4.6.2. Drives

4.6.2.1. Private drive

The Private drive contains personal data of registered users. Hence, only these individuals can

access data in this drive type.

By default, there are some initialized folders to store private resources of users.

In Private drive, there are many functions on the Action bar, including:

• Create new folders/documents.

• Upload files from your computer.

• Add Symlinks.

• Overload Thumbnails.

• Watch/Unwatch documents.

• Add tags to a document.
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• Set multiple languages for a document.

• Vote for a document.

• Comment on a document.

• By selecting the Search tab, you can:

• Do the simple search.

• Do the advanced search with more constraints, or by adding new queries to search.

• Do search by existing queries.

• In addition, you can:

• Set up your browse preferences.

• Cut/Copy/Paste/Delete nodes.

• Lock nodes.

• Rename nodes.

• View document content by the WebDAV function.

• Download documents (folders) to your machine.

4.6.2.2. Public drive

With the Public drive, there is no initialized folder but you can create by yourself.

In the Public drive, you also can take similar actions to those in the Private drive.

4.6.2.3. Personal Documents drive

This drive consists of some initialized folders as the Private drive.
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In the Personal Documents drive, you also can take similar actions to those in the Private drive.

4.6.2.4. Drive of a specific group

By default, there are two initialized folders but you also can add more and take actions that is

similar in the Private drives. Only users in a specific group can access its drive.

Note

Drives which are created during space creation are visible and accessible by their

members only.

The space drives only can be deleted when the spaces are deleted by the space

manager.

4.6.2.5. Hide/Show the sidebar in a drive

The sidebar is used to show nodes like a tree or show the related documents, tags, clipboard

and saved searches.

You can hide/show the sidebar in two ways:

The first way

1. Click  to open the Preferences.
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2. Deselect the Show Sidebar checkbox, then click Save to accept your changes.

• To show the sidebar, tick the Show Sidebar checkbox in the Preferences form.

The second way

• Simply click  to hide the sidebar as the illustration below.

The drive will be displayed like the illustration below.

• Click  to show the sidebar.
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4.6.3. Views

There are many drives in Sites Explorer. Each drive has some views that enable you to view

data in the drive in a particular way. Each view has some action tabs and each action tab contains

some functions.

eXo Platform supports you some ways to view nodes in a specific folder and show actions of

corresponding tab on the Action bar.

Note

The number of view types depends on which drive you are browsing. In eXo

Platform, you can manage view types by selecting  --> Content --> Content

Administration --> Content Presentation --> Manage View. See the Manage

views section for more details.

4.6.3.1. Admin view

In this view, each item in the list includes following information: Name, Versionable, Owner, Date

Modified , and Date Created. These information will help you manage nodes easily.

You also can sort nodes to the nodes information by clicking the label of corresponding column.

•  indicates that nodes are ordered in the ascending order.

•  means nodes are in the descending order.

4.6.3.2. Cover Flow view

This view is defined as a dynamic one with the side-scrolling view to nodes in a folder. In this view,

when a node is selected, its name is set with bold effect to more outstanding than others.
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To move from one node to another one, you can do one of these ways:

• Use the mouse wheel.

• Hold and move the yellow circle button to the left or the right.

• Click the folder/document name that you want to select.

4.6.3.3. Icons view

In this view type, nodes in a specific folder will be viewed as icons. The name of each node will

be shown under its icon.

4.6.3.4. Thumbnails view

By using the Thumbnails view, nodes in a specific folder are viewed as icons bounded by frames.

Name of each node is shown under its icon.

If nodes are image files, their thumbnails will be shown like the screenshot below.



Views

71

4.6.3.5. Slide Show view

In this view type, pictures in folders are viewed in the slide show.

To view pictures in the slide show, click .

If nodes are pictures, they are displayed like the following illustration.

The Slide Show view automatically shows all picture nodes. Users can control this slide show

by clicking the below buttons.

Table 4.14.

Button Function

Go to the first picture node.

View the previous picture node.
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Button Function

Pause the slide show. After clicking this button,

 will become . Click  to continue viewing

the pictures node.

View the next picture node.

View the last picture node.

4.6.3.6. Timeline view

This view enables users to view all document nodes created and uploaded by simply clicking .

All the document nodes, which have been created and uploaded, will be displayed.

• Click the node name to view its content in details.

• Click a timeline category, such as Today, Yesterday, Earlier This Week, Earlier This Month,

and Ealier This Year to review all the nodes of the category. Click it again to return the the

default.

• Click  to mark your item as favorite, or  of a favorite node again to remove it from favorites.

4.6.4. Functions on action tabs

Functions are added to tabs in Sites Explorer by administrators. The number of displayed actions

depends on each tab and each drive you are browsing and your role.

This section shows you how to take all actions in Sites Explorer.
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4.6.4.1. Add a category

This function enables you to add a category to a node.

1. Select a node to which you want to add a category.

2. Select  on the Action bar to open the Add Category form.

3. Enter a name for the category in the Category Name field.

4. Click Save to accept creating the new category.

4.6.4.2. Add a document

There are several types of document in eXo Platform, such as File, Article, Podcast, Sample

node, File Plan, Kofax, and more.

The table below shows types of nodes which can be added to various document types. The rows

indicate which nodes in the left column can be added. The columns indicate which nodes at the

top can contain.

Table 4.15.

File Article Podcast Sample

node

File

Plan

Kofax

document

Content

folder

Document

folder

File

Article    

Podcast

Sample

node

    

File

Plan

  

Kofax  

Uploaded

file

Content

folder

  

Document

folder
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Note

 indicates that the corresponding document can be added into. A blank entry

means that the corresponding document cannot be added into.

Following the horizontal, you will know which nodes can be added.

Following the vertical, you will know which node can be included.

Add a new document

1. Select a folder from the left pane where you want to add a new document.

2. Click  on the Action bar to open a list of content templates.

3. Click your desired template. See more details in Step 3 [46] of the Add content section.

Each document (except Article) must be added to categories when being created.

Attach files to a document

1.
Select a document or a folder that you want to attach files, and click  on the Action

bar.

The Upload File form will appear.
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2. Enter a name into the Name field. If not, the Name field is automatically filled with the file

name.

3. Click Browse... to select the attachment file. You can click  to add more files.

4. Click Save to attach the files.

To view the attached file directly in Sites Explorer, simply click its name.

Note

eXo Platform enables you to view all types of documents, such as Open Office,

Microsoft Office in the PDF format.

Create a new File document

1. Follow the steps in the Add a new document [74] section to open the corresponding form

to add a File document.

2. Input a name for the file document in the Name field. Some special characters (@ # % & *

( ) “ ' : ; [ ] {} / !) cannot be used in the Name field.

3. Click the Mime Type field and select one type. There are three types of File document:
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• text/html: when creating a text/html File document, you can input values like source code

(HyperText Markup Language HTML) in the Content field . After being created, it will

generate the content you want, then you can see both the input source code and the

generated content in that document.

• text/plain: after a text/plain File document is created, it will display exactly what you input

in the Content field.

• application/x-groovy+html: it indicates your file as a groovy file.

4. Input a value in the Content field:

• text/html or application/x-groovy+html: if you want to create a File document with a

source code and generated content, click the  button in the Editor bar.

• text/plain: if you select text/plain type, the content field will be displayed like the following

illustration.

5. Optionally, fill values in all the rest fields, including Title, Description, Creator and Source.

Click  to open more fields.

6. Click Save or Save & Close to accept creating a new file document.

After being created successfully, a file document with the text/html type will be displayed like

the illustration below.
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Create a new article

1. Follow the steps in the Add a new document [74] section to open the corresponding form

to add a new Article document.

2. Input name and title of the Article in the Name and Title fields. Special characters (@ # % &

* ( ) " ' : ; [ ] {} / !) are not allowed in the Name field.

3. Input values for both fields: Summary and Content.

4. Click Save or Save & Close to accept the inputted values.

After being created, your newly added Article document will be shown as below.
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The Links area lists all its related documents. After adding relations to a document, Article will

be displayed. You can click these links to view the content of the related documents. For more

details about how to add a relation to a document, refer to the Add a relation section.

The Attachments area lists all its uploaded files/documents which are attached with the Article.

You can remove the attachments by clicking .

For more details about how to add an attachment, see the Attach files to a document [74]

section.

Note

The name of document may be as the same to that of the existing one. When a new

document is created with the same name as other existing document, a numeric

index will be added to the name (for example, test [2]).

Create a new Podcast

1. Follow the steps in the Add a new document [74] section to open the corresponding

Podcast form.

Details:

Table 4.16.

Field Description

Name The document name which is required.

Special characters (@ # % & * ( ) “ ' : ; [ ] {} / !)

are not allowed in the Name field.

Categories Categories of a document.
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Field Description

Title The display name of a document.

Link The link to the source path of the uploaded

media file that is required.

Author The author of the uploaded media file.

Explicit It is used to indicate if your Podcast episodes

contain an explicit content or not.

Category The category of the uploaded media file, for

example music, film, or short clip.

Keyword This field allows you to search your Podcast

files more quickly. You can use commas to

separate between keywords.

Publish Date The date when an episode was released.

Description Information about the uploaded media file.

Mime Type The type of the uploaded media file.

Length The length of the uploaded media file.

2. Input values for fields. To upload a media file, click Browse... and select the media file from

your device.

3. Click Save or Save & Close to finish.

Once being created, a Podcast will be displayed.

Create a new Sample node

1. Follow the steps in the Add a new document [74] section to open the Sample node form.
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2. Complete the appropriate fields.

3. Click Browse... to locate your desired image, and upload it.

4. Click Save or Save & Close to finish.

After being created, a new sample node will be displayed.

The Relations area is used to list all its related documents. See the View relations  section.

You can click the links to view content of the related document.

The Attachments area is used to list all its uploaded files. See the Attach files to a

document [74] section for more details.

Create a new File Plan

1. Follow the instructions in the Add a new document [74] section to open the corresponding

form to add a File Plan document.

Details:

• The Name tab
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Table 4.17.

Field Description

Name The name of the file plan.

Categories Categories of your file plan. Select the

categories for your file plan by clicking .

Language The language of the File Plan document.

File Plan Note Note for presenting any other information

for users.

• The Record Properties tab

Table 4.18.

Field Description

Record Category Identifier The alphanumeric identifier indicates a

unique record category. This must be a

unique ID. If this field is left blank, it will be

created automatically by the system.

Disposition Authority A reference number to the regulations that

govern the disposition.

Permanent Record Indicator A type of record indicators which should

never be deleted.

Disposition Instructions A readable guideline on how to handle the

records associated with the file plan.

Contains Records Folder The confirmation is about whether the

records folder is contained or not.

Default Media Type The choice for preset media types which

are made available to simplify the data entry

for the record. The frequently-chosen value

is "electronic" or paper.
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Field Description

Default Marking List Handling and classifying information that is

printed at the bottom of the record, such as

UNCLASSIFIED, or NOCONTRACT.

Default Originating Organization This option is to enter the original

arrangement as default which is made

available to simplify the data entry for

the record and to assume that originating

organizations are the same for the

information in the file plan.

Vital Record Indicator This flag is to allow tracking or reminding

you of the record as essential or not.

Vital Record Review Period The choice for the interval of time between

vital record reviews.

• The Process Properties tab

Table 4.19.

Field Description

Process Cutoffs The Boolean data type is used to break a

process. If the process cutoff flag is set in

the file plan, the record is cutoff after the

expiration, or after it has been obsolete or

superseded, depending on the information

in the file plan.

Event Trigger The text data type is an automatic executing

code which is used to tell the event to

perform some actions.

Cutoff Period The duration for the record cutoff

performance.

Cutoff on Obsolete The record is cutoff when it is obsolete.
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Field Description

Cutoff on Superseded The record is cutoff when it is removed or

replaced.

Process Hold This boolean data type is used when a

record process may be held before the

further disposition is handled.

Hold Period The duration when a record may be held

after cutoff which is normally measured in

Years.

Discretionary Hold The Boolean data type is used when a

hold may be discretionary, such as after

a command change. So, the discretionary

hold flag allows the records management

module to track these manual checks.

Process Transfer The boolean data type is used to determine

how a record process will be transferred.

Default Transfer Location The text data type is used to determine

where a record is transferred by default.

Transfer Block Size The float data type is used to determine

in what size blocks for organizational

purposes that is normally measured in

Years.

Process Access The Boolean data type is flagged when a

record, which is held permanently, must

be ultimately transferred to the national

records authority.

Access Location The text data type is flagged to specify an

area for the access transfer.

Access Block Size The text data type is flagged to determine

the blocks size for organizational purposes

which is normally measured in Years.

Process Destruction The Boolean data type is flagged if there

is any record to be destroyed. After that,

the record is marked in the Alfresco system

to be permanently destroyed so that all

information, metadata and physical traces

are removed and cannot be recovered.

2. Fill in the appropriate fields of the tabs in the form.

3. Click Save or Save & Close to finish.
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Create a new Kofax document

1. Follow the instructions in the Add a new document [74] section to open the Add Kofax

Document form.

2. Input a name for a Kofax document in the Name field which is required. Special characters

(@ # % & * ( ) “ ' : ; [ ] { } / !) are not allowed in this field.

3. Select categories for a Kofax document by clicking .

4. Click Save or Save & Close to finish.

After being created, a Kofax document will be displayed.

• The File View tab is used to display all added nodes in that Kofax. Besides, all added files in

Kofax are also displayed in the Document View tab.

Create a new event

1. Follow the instructions in the Add a new document [74] section to open the Add an event

document form.

2. Enter a title for the event.

3. Input the location where the event will take place in the Location field. Select the Google

Maps checkbox if you want the location of the event to be shown on Google Maps.

4. Enter the Start and End Date/Time of the event.

5. Fill the Summary and Content fields.

6. Click Save or Save & Close to finish.



Functions on action tabs

85

After being created, the event will be displayed like the illustration bellow.

Create an accessible media

1. Follow the instructions in the Add a new document [74] section to open the content

template list, and select the Accessible Media template.

Details:

Table 4.20.

Field Description

Name The document name which is required.

Special characters (@ # % & * ( ) “ ' : ; [ ] {} / !)

are not allowed in the Name field.

Categories The name of the selected categories.

Language The language of the media.

Content The content of the media which is required.

Title The display name of the media.

Creator The creator of the media.

Source The source of the media.
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Field Description

Captions Provide the text of the dialogue and

important sounds.

Audio description Provide the narrate track of the media. You

can browse and upload another media file

from your local device to set it as the audio

description.

Alternative text Provide the descriptive information about the

media.

2. Input the information in the fields, and attach existing files from your local device to the

following fields:

• Content: It must be a .flv or .mp3 file.

• Captions: It must be a .srt or .mp3 file.

• Audio description: It must be a .flv or .mp3 file.

3. Click Save or Save & Close to finish.

The accessible media can be played right after being created.

Details:

Table 4.21.

Button Function

Stop the media.

Play the media. After clicking this button,  will

become  and vice versa.

Play the previous media.
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Button Function

Play the next media.

Listen to the audio description. This icon only

appears if you attach another media with the

audio description to the Audio description

field. After opening the audio description, to

back to the original media, click .

Activate/Deactivate the media caption. If you

attach an .srt or .xml file to the Captions field,

the caption will appear when you clicking this

button.

Note
You can also attach Captions and Audio description to the uploaded media

when editing this document. To know how to upload a file, see the Attach files to

a document [74] section.

4.6.4.3. Add a folder

You can create a document immediately in a specific drive. However, adding a document to a

specific folder enables you to manage documents better.

There are two types of folder:

• Content folder.

• Document folder.

In the default skin, the icon for a content folder node is displayed in blue and the icon for a

document folder node is displayed in yellow.

File and folder types in a folder

Content folder

• Add a Content folder to a Content one.

• Add a Document folder to a Content one.

• Add documents to a Content folder.
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• Upload files (images, MS Word documents, Open Office documents, .pdf files, .txt files, .xml

file, and more) into a Content folder.

• Import sub-nodes which were exported into a Content folder.

Document folder

• Add a new Document folder to a Document folder.

• Add File, Podcast, File Plan documents to a Document folder.

• Upload files (images, MS Word documents, OpenOffice documents, .pdf files, .txt files, .xml

file, and more) into a Document folder.

• Cannot add a Content folder to a Document folder.

• Cannot import an exported Content folder into a Document folder.

• Cannot import an exported Article, Sample node, Kofax into a Document folder.

Create a folder

1. Select the path to create a folder.

2. Click  on the Action bar to open the New Folder form.

3. Select a folder type.

4. Input values for both Name and Title fields which are required. Special characters (@ # %

& * ( ) " ' : ; [ ] {} / !) are not allowed in these fields.

5. Click Save to accept creating a new folder.

Note

The name of a folder may be the same as that of the existing one. When a new

folder is created with the same name as other existing folders, an index will be

added to the name of your newly created folder (for example, test[2]).

You can only create a content folder in another content folder.

You can create a document folder in a content folder or a document folder.
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4.6.4.4. Add translations to a document

This function enables users to add multiple languages for a document. This action is similar to

adding a language.

1. Select a document to which you want to add the translation. For example, select an Article

in English.

2. Click  on the Action bar to open the Symlink Manager form.

3. Click , then browse to the target document that has different language with the first

document. For example, the Article version in French.

4. Click Save on the Symlink Manager form.

5. Select the document to which you have added the translation, then click the Relation button

on the Filter bar.

You will see the available language for the selected document. Click the language on this

pane to view the document in the corresponding language version.
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4.6.4.5. Add a Symlink

A symlink in Content works like shortcut to a directory or file. To add a Symlink, you can follow

one of these ways.

The first way

1. Select a node where you want to add a Symlink.

2. Click  on the Action bar to open the Symlink Manager form.

Details:

Table 4.22.

Field Description

Path Node The path to the target node.

Symlink Name The name of the Symlink.

3. Click  to open the Select Target Node form.

4. Select the workspace which contains the node that you want to add a Symlink.

5. Click  in the row of the node that you want to add. The path that the node will appear in

the Path Node field and the name of the node is set by the name of the selected node. You

can also edit this name.
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6. Click Save to finish adding a Symlink.

The second way

1. Right-click a node that you want to create a Symlink. Note that if you follow this way, the

Symlink will be created to the current node.

2. Click Add Symlink from the drop-down menu.

This node will become a Symlink to the current node.

Note

You should notice the different behaviour between adding a Symlink via the Action

bar and the right-click menu.

• After you have right-clicked a node, then selected Add Symlink, a Symlink to

the current node is created.

• Meanwhile, when you select Add Symlink on the Action bar, a Symlink

Manager form will appear to let you select the target node.

Warning

You will get an error message if you create a Symlink inside the following content

types: Article, CSS, Event, HTML, JS, Kofax, Podcast, Sample node, Weblink.
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4.6.4.6. Comment

This function is used to comment on a document.

Note

You cannot comment on a File Plan document.

1. Select a document to which you want to add your comment.

2.
Click  on the Action bar to open the Comment form.

3. Add your comment to the Comment field.

4. Click Save to commit.

The comments are shown at the bottom of the document.

To view your comment, click the Show comments link:
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You can edit your comment by clicking  or delete it by clicking .

4.6.4.7. Edit a document

There are two ways to edit a document.

The first way

1. Select a document you want to edit in the left panel.

2.
Click  on the Action bar.

The second way

1. Select a folder that contains the document you want to edit.

2. Right-click the document you want to edit and select Edit from the menu.

The form to edit the document will appear. All information of the selected document will be

displayed in this form and ready for you to change except the Name field.

3. Click Save to commit your changes.

4.6.4.8. Export nodes

Nodes can be exported into either .xml or .zip file types.

1. Select a node that you want to export.

2.
Click  on the Action bar to show the Export form.

Details:

Table 4.23.

Fields Description

Path to Export The path of the node being exported. This

field will be pre-populated.
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Fields Description

Format The format of the original node.

System View Each node and each property of that node is

included in a different tag.

Document View Each node is a tag and properties of that

node are considered to be elements of that

tag.

Zip If this field is checked, the node will be

exported as a .zip file.

3. Click Export and select a location to save the exported file.

Note

The Export form can contain Export Version History if the exported node or

any of its child nodes is versioned.

This action exports all of the node's version history.

4.6.4.9. Import nodes

Nodes which are in the .xml file format can be imported into the JCR Explorer system.

1. Select the location where you want to import the new node.

2. Click  on the Action bar. The Import form appears.

3. Click Browse... next to the Upload File field and navigate to the file you want to import.

4. Select one value from the UUID Behaviour drop-down menu, including:

Create New

If you select this behavior, the imported nodes receive new UUIDs which are completely

independent of any existing nodes. As the imported nodes get new UUIDs, there are

no UUID conflicts with the existing nodes in the workspace. The existing nodes in the

workspace are not moved, modified or deleted. The imported nodes are considered as
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new nodes and therefore, do not have a version history. You cannot import a version

history for these nodes.

Remove Existing

If you select this behavior, the imported nodes in a selected path receive the same UUIDs

of the exported nodes. As the result, there is UUID conflicts with the existing nodes.

Therefore, the existing nodes are removed from the workspaces and the new nodes will

have the same version history as the existing nodes.

Replace Existing

If you select this behavior, you only can import the exported nodes into their original

workspaces where they are exported. When the new nodes are created with the same

UUIDs of the existing nodes, causing UUID conflicts with the existing nodes in the

workspaces. Therefore, the existing nodes are replaced by the new ones in the same

location and the new nodes have the same version history as the existing nodes.

Throw Exception

If you select this behavior, there is a message which will alert that you can not import this

node in case this node has been existing in the workspace. If this node hasn't existed,

a new node will be created.

5. Click Browse... next to Version History to select a version to import.

6. Select a format.

7. Click Import to import the file's selected version.

4.6.4.10. Manage actions

4.6.4.10.1. Add an action

1. Select the node to which you want to add an action.

2.
Click  on the Action bar.

The Manage Actions form will appear.

3. Select the Add Action tab.
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Details:

Table 4.24.

Field Description

Name The name of this action. This name is internal

to the JCR explorer.

Lifecycle Select the lifecycle for this action. The action

will be executed, depending on the lifecycle:

• 'User Action': The action is executed

when right-clicking the folder and then

selecting the action.

• 'Content Addition': The action will be

executed on a new document, but not

on a subfolder when the document or

the subfolder is created in the folder to

which an action has been added. It is also

applied to a new document in the subfolder

of the folder.

• 'Content Removal': The action will be

executed on a document, but not on a

subfolder in the folder when the document

or the subfolder is moved.
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Field Description

• 'Property Addition': The action will be

executed on a document when a property

is added to the document.

• 'Property Removal': The action will be

executed on a document when a property

is removed from the document.

• 'Property Modification': The action will

be executed on a document when a

property of the document is modified.

• 'Schedule': The action is done at specific

time.

If you need the same action to be executed

in several lifecycles, you have to create

several actions.

4. Select one type for your action from the Create Action of Type drop-down menu.

Details:

Table 4.25.

Field Description

exo:AddMetadataAction Add metadata.

exo:autoVersioning Add a version automatically.

exo:createRSSFeedAction Create an RSS file.

exo:enableVersioning Enable versioning.

exo:getMailAction Fetch mails.

exo:populateToMenu This type is not supported.

exo:sendMailAction Send mails.

exo:taxonomyAction Create categories.

exo:transformBinaryTo TextAction Convert .pdf or .doc file types into plain text.
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5. Complete all the fields in the form. The Name and Lifecycle fields are required.

6. Click Save to commit the action.

All actions of a node are listed in the Available Actions tab.

Once an action is added to a node, it is auto-added to any child nodes of the selected node.

If an action is added with the lifecycle named 'User Action', it will be applied to the current node.

If an action is added with other lifecycles, it will be applied to the child nodes.

Note

Not all actions are listed in a right-click menu of nodes. Some actions can be

performed immediately when that action is added.

4.6.4.10.2. View actions

1. Open the Manage Actions form and select the Available Actions tab.

2. Click  that corresponds to the action you want to view.

The details will be displayed in the Action Info tab.

4.6.4.10.3. Edit an action

1. Open the Manage Actions form and select the Available Actions tab.

2. Click  that corresponds to the action you want to modify.
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3. Edit properties in the Action Form.

4. Click Save to accept your changes.

4.6.4.10.4. Delete an action

1. Open the Manage Actions form and select the Available Actions tab.

2. Click  that corresponds to the action you want to modify.

3. Click OK in the confirmation message to delete the action.

4.6.4.11. Manage auditing

This function logs property changes in nodes.

1. Select a node.

2.
Click  on the Action bar. The Activate Auditing message appears.
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3. Click Activate to enable auditing on the selected node.

4.
Click  again to view the audit information of the selected node.

The Auditing Information list appears.

If the node has no audit information, the form will appear as below.

4.6.4.12. Manage categories

4.6.4.12.1. Assign a category to a node

You can add categories to the document type nodes only.

1. Select the node to which you want to add a category.

2. Click  on the Action bar.

The Add Category form appears.

3. Select the Select Category tab to show the available categories.

4. Click  to add the corresponding category to the node.

The category, which has been added to a node, is listed in the Referenced Categories tab.

All nodes, which belong to a category, can be viewed as follows:
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View a category

1. Go to the drive which contains the category you have added. There will be a list of categories

available.

2. Select your desired category. The documents in that category will be listed.

Note

When copying and pasting a node in a drive, a new node with the same content

will be created with a different name.

When copying and pasting a node in the category tree, a reference to the original

node will be created. This reference is a link rather than a copy. This feature is

used to preserve the disk space.

4.6.4.12.2. Delete a category

1. Select a categorized node.

2. Click .

3. Select the Referenced Categories tab.

4. Click  that corresponds to the category you want to delete.

4.6.4.13. Show/Hide content

Nodes can be hidden or shown easily.

Hide a node

1. Select the node you want to hide.

2. Click  on the Action bar to hide the node.
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A confirmation message, which notifies that the node has been hidden, will appear.

Show a node

To show a hidden node, click  again.

4.6.4.14. Manage publication

This function is used to manage node publication.

1. Select a node (on the left or right pane) which you want to manage its publication.

2.
Click  on the Action bar.

The Manage Publication form appears.

The Revision tab displays some basic information and the current state of the selected node.

3. Click  to view the content of the node or click  to restore a version (refer to the Manage

versions section for information about versioning).

4. Select the History tab to view the publications history of the node.

5. Click Save to accept your changes.

Note

See the Publication process section to understand more Manage Publication.

4.6.4.15. Manage relations

You can use this function to create relations between nodes.
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4.6.4.15.1. Add a relation

1. Select the node you want to add a relation to.

2.
Click  on the Action bar.

The Add Relation form appears.

3. Select the Select Relation tab to see a list of other documents.

4. Click  that corresponds to the documents related to the document selected in the Step 1.

Documents linked to the original via a relation will be listed in the Relation List tab.

Note

Relations can only be added to document and uploaded file node types.

A node cannot have a relation to itself.

4.6.4.15.2. Delete a relation

1. Select a node that has links to related documents.

2.
Click the  button on the Action bar.

3. Select the Relation List tab to view relations of the selected node.

4. Click  corresponding to the relation you want to remove.

5. Click OK in the confirmation message to accept your deletion.

The related document will be removed from the list.

4.6.4.15.3. View relations

1. Select a node that has links to related documents.

2. Click  on the Filter bar.

All nodes related to the selected node will be displayed in the Relations List in the left pane.
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3. Click the name of the related node to view the document.

4.6.4.16. Manage versions

4.6.4.16.1. Add versions to a node

1. Select a node to add a version to.

2.
Click  on the Action bar.

The following message will appear.

3. Click Activate to enable a version for the node.

4. Right-click the selected node and select CheckIn from the drop-down menu.

5.
Click  again to open the Version Info window.
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The node selected in Step 1 has been added as the Base version..

6. Right-click the node again and select CheckOut to obtain a version of this node.

Note

No actions (copying/cutting/renaming) can be taken on a node in the CheckIn

status. You must check it out before you can perform any actions on it.

If you want to add more versions to a node, right-click the selected node above

and select CheckIn and then CheckOut.

4.6.4.16.2. Add/Remove labels for versions

Add a label

1. Select a versioned node.

2.
Click  on the Action bar.

3. Click  icon on the Version Info window to show the Add Label field under the version list.

4. Enter a value into the Label field.

The label must be unique without containing any special characters, such as @, #, $.

5. Click Save to submit the new label.

Remove a label

1. Select a versioned node which has at least one label.

2.
Click  on the Action bar.

3. Click  on the Version Info window to show the Remove Label field under the versions list.
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4. Select the label you want to remove from the drop-down menu.

5. Click the Remove button to remove the selected label.

4.6.4.16.3. View versions

1. Select a versioned node.

2.
Click .

3. Click  to see the current versions of the selected node.

Note

Version viewing is not supported on folder nodes.
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If you click  while the selected node is a folder, a message will appear.

4.6.4.16.4. Restore a version

1. Select a node which has at least two versions stored.

2.
Click .

3. Select the version that you want to restore as the base version.

4. Click  to restore the selected version.

4.6.4.16.5. Delete a version

1. Select a node which has at least two versions.

2.
Click .

3. Click  corresponding to the version you want to delete.

4. Click OK in the confirmation message to accept your deletion.

Note

You cannot delete a base version.

4.6.4.17. Multi-Languages

This function is used to add multiple languages to a document. Each document can be displayed

in many languages.

1. Select a document that you want to add languages.

2. Click  on the Action bar.

The Multi Language form will appear.



Chapter 4. Basic Actions

108

The View Language tab contains a list of all languages. The default language for the

document will be automatically populated.

3. Select the Add Language tab. This tab will be displayed differently, depending on which file

you selected. However, the area where you can add languages to a document is the same.

The below illustration shows the Add Language tab for a Sample node file:

4. Select a language you want to add from the Language drop-down list.

If the selected language has not been added to the current document, the content field will

be blank.

Select the Set Default checkbox if you want to set your selected language as a default

language.

5. Click Save to be returned to the View Language tab. Your selected language is now added

to the Language field.

You can view this document in your newly added language by selecting that language from

the Language drop-down list, then click the View button.

View the languages list of a document

1. Select a document that you want to view the languages list, then click the Relation button

on the Filter bar:

2. The list of language (and all related documents) will be displayed in the left pane.
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You can view the document in the new language by clicking the corresponding link in

Languages List.

For more details about Relations, refer to the Views relations  section.

Note

You cannot add multiple languages to a File Plan document.

When a document is a sub-node of File Plan, you also cannot add language to it.

4.6.4.18. Overload thumbnails

You can overload a thumbnail image for a folder. Overloading allows a folder to be represented

by a thumbnail image, rather than a folder icon (see the Thumbnail view section).

1. Select the folder you wish to overload with a thumbnail image.

2. Click  on the Action bar.

The Add Thumbnail Image form appears.

3. Click the Browse... button to select the image which will be used as the display icon for the

selected folder.

4. Click Save to accept your changes. The node will be stored in an exo:thumbnails folder.
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4.6.4.19. Request approval

If you want to publish one created content but you do not obtain the 'Publish' right, you must send

a request for approving your content.

1. Select the content that you want to send the request for publishing it.

2. Click  on the Action bar.

The content is displayed at the bottom of the Sites Explorer of the people who have the right

to approve content.

4.6.4.20. Approve content

When content is created by users, it is possible to approve the publication if there is an approval

request. To approve content, do the followings:

1. Select content that needs approving.

2. Click  on the Action bar and the content is ready to be published.

Note

The Approve Content button is only visible for users who have the right to

approve content.

By default, this button is not displayed on the Action bar.

Enable this function by selecting  --> Content --> Content Administration

--> Content Presentation --> Manage Views.  See the Manage views section

to know how to add the Approve Content button to the tabs on the Action

bar in  Sites Explorer.

4.6.4.21. Publish content

After the content is approved, it can be published by people who have the "Publish" permission.

1. Select content that you want to publish.

2.
Click  on the Action bar. The content will be published as the schedule that you

set up.
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Note

The Publish button is only visible for users who have the "Publish" right.

By default, the button is not displayed on the Action bar.

Enable this function by selecting  --> Content --> Content Administration

--> Content Presentation --> Manage Views. See the Manage views section

to know how to add the Publish Content button to the tabs on the Action bar

in Sites Explorer.

4.6.4.22. Show drives

This function enables you to show or hide all the drives in Sites Explorer.

To show drives, click  on the Action bar.

To hide drives, click  again.

4.6.4.23. Show/Hide content structure

This function allows you to view document nodes in a tree structure.

Show the JCR Structure

1. Select a document.

2. Click  on the Action bar.

Hide the JCR Structure

1. Select a document which is showing the JCR structure.

2. Click  again.

4.6.4.24. Tag documents

A tag is a keyword or term associated with or assigned to a piece of information (a picture, a

geographic map, a blog entry, a video clip, and more). Each tag describes one item and enables

the keyword-based classification and search of information.

Add a new tag to a document
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1. Select a document to which you want to add tags.

2. Click  on the Action bar. The Tag Manager will be displayed.

Details:

Table 4.26.

Field Description

Tag Names The tag names that users want to add tags

to documents.

Tag Scopes Classify the tags. There are four tag types:

private, public, group, and site. Currently, the

two first types are activated ("Private" means

that a user who creates tags can view and

edit tags; "Public" means that all users can

view and edit tags).

Linked Tags List all tags of a document after the Add

Tags button has been clicked.

3. Input a value into the Tag Names field. Several tags can be added to a document at a time.

To do that, input all tag names in the Tag Names field and separate by commas.

4. Select a value for the Tag Scopes field.

5. Click Add Tags to accept, or Close to quit. Only you can see this tag in this document.

6. Click  to delete tags.

Remove tags from a document

1. Select a document with tags that you want to delete the tags.

2.
Click  on the Action bar to open the Tag Manager form.
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3. Click  corresponding to the tags you want to delete.

4. Click OK in the confirmation message to delete the tags.

4.6.4.25. Upload files into folders

This function allows you to upload a file from your device. All file types can be uploaded. Special

characters (! @ $ % & [ ]) are not allowed.

1. Select the folder that you want to upload a file into from the left/right pane.

2.
Click  on the Action bar to open the Upload File form.

3. Browse and select a file on your device by clicking the Browse... button. The selected file

name will be displayed in the Select File field.

If you want to upload multiple files at the same time, click  to open more Upload File forms.

Click  to close a Upload File form.

To change the uploaded file, click  in the Select File field and select Browse... again to

select another one.

4. Optionally, type a name in the Name field which is not required. Special characters (! @ $ %

& [ ]) are not allowed in this field. If not, the name of the uploaded file will be kept as original.

5. Click  next to the Categories List field to select categories to which you want to add this file.
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i. Select a category in the left pane to open its child nodes in the right pane.

ii. Click  corresponding to a child node that you want.

Note

You can add more categories to a file by clicking  again to open the Add

Categories form.

Click  to delete a category in Upload File form.

You also manage categories which have been added to files by using the

Manage Categories function. See the Manage categories section.

6. Complete uploading file by clicking Save.

After being saved, the main information of the uploaded file will be displayed.
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7. Optionally, click  to see more details about its external metadata information. The List

External Metadata tab will be enabled and you can do some actions in this tab.

• Click  corresponding metadata that you want to edit.

• Click Add metadata to add more metadata to the uploaded file. Then, tick the checkbox,

and click Add.

The new metadata are displayed in the List External Metadata tab.

8. Click Close to quit the Upload File form.

After being uploaded, the tree is displayed in the left pane.

Note

The size of the uploaded file depends on the size limit of the uploaded file that you

set up in the 'Edit' mode of Sites Explorer. If your file size exceeds the limit, the

alert message will appear.
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4.6.4.26. View metadata

This function allows you to view metadata attached to File nodes, Podcast nodes, File Plan child

nodes and uploaded file nodes (nt:file nodes).

1. Select an appropriate node (nt:file).

2.
Click . The View Metadata form appears.

3. Click the Add/Edit button at the bottom of the View Metadata form to add metadata.

4. Complete the desired fields in the Add/Edit Properties form. Click  to add further metadata.
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5. Click Save to accept the new metadata values.

4.6.4.27. View node types

This function allows you to view the detailed information of a node.

1. Select a node that you want to view its detailed information.

2.
Click  to view detailed information about the selected node.

3. Click the tabs at the top of the form to view categorized information.

4.6.4.28. View permissions

This function allows an administrator to manage the permissions for nodes.
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1. Select a node.

2. Click . The Permission Management form appears.

By opening the Permission Management form, you can perform the following actions:

• Add permissions [118]

• Edit permissions [120]

• Delete permissions [120]

Add permissions

1. Select a user or a group to whom you want to assign permissions.

• Click  next to the User Or Group field to add permission for a specific user.

The Select User Permission form appears.
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Click  corresponding to your desired user. Also, you can use the Search function to look

for your desired users quickly.

Search for users

Search for a user in a specific group

• Enter a group name in the Group field at the top of the form (for example, /platform/

users). Then press Enter. All users in the nominated group will be displayed.

• Or, click  beside the Group field to open a form that lists groups and their sub-groups.

Select a sub-group and all users of the sub-group will be displayed.

Search for a user in any groups by Username, First Name, Last Name, or Email

• Enter the information of the user ino the textbox.

• Click  to search for users matching with your selected information.

• Click  next to the User Or Group field to add permissions based on memberships.

Then, select a group in the left pane, and membership types in the right pane in the Select

Membership form.

• Click  next to the User Or Group field to assign the "read" permission to all users/groups.

2. Select the permission you want to grant the selected users or groups by ticking the

corresponding checkboxes beside rights you want to add.

3. Click Save to accept your changes. The new permissions will appear in the permissions table

above.
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Edit permissions

1. Select the permission of a user or a group in the permissions table.

2. Click .

3. Change the permissions as desired.

4. Click Save to accept your changed permissions.

Delete permissions

1. Select the permission of a user or a group in the permissions table.

2. Click .

3. Click OK in the confirmation message to remove the permission.

4.6.4.29. View properties

This function allows users to review all the properties and values of a node. It can also be used

to add values to a node.

1. Select the node you want to review or add values to.

2. Click  to show the Properties Management form.

This form has two tabs:

Properties

This tab displays all properties and values for the selected node.
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Add New Property

This tab contains fields to add new properties to the selected node.

3. Select the Add New Property tab to add new properties to the selected node.

4. Select the namespace for the property.

5. Enter a name for the new property in the Name field.

6. Select the property type from the Type drop-down menu.

7. Enter a value for the property in the Value field.

To add multiple new values, click  and repeat the above steps.

To remove a value, click .
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8. Click Save to accept your new values, or Reset to clear all modified fields.

After you have made changes on new properties, you will be returned to the Properties tab. The

newly added values will be displayed.

In this form, you can edit a property by clicking , or delete it by clicking .

4.6.4.30. View relations

This function shows/hides documents related to a selected node.

• View relations

Select a node, then click . Documents related to the selected node will be

shown in the Filter bar.

If the node does not have any related documents, the message No Related Document will

appear instead.

• Hide relations

Click  again to hide relations.

4.6.4.31. Vote for a document

This function is used to vote for a document.

Note

You cannot vote for a File Plan document.

1. Open the document you want to vote for.

2.
Click  on the Action bar.
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The Vote Document form will appear.

3. Rate the document by clicking the appropriate star level.

After a vote has been added, the rating will appear at the bottom of the document:

4.6.4.32. Watch/Unwatch documents

By using this function, whenever any change is made on the document, a notification message

will be sent to your email address. To receive that email, you must configure in your mail server.

Watch a document

Select the document you want to watch and click .

The Watch Document form will appear. Click the Watch button to finish.

Stop watching a document

Select the document and click .

A message will appear to confirm the action.
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4.6.5. Manage content in Sites Explorer

Web content is a key resource which is used for a site. Other resources make a site more dynamic

and animated by using layout, color, font, and more. This section focuses on how to manage web

content in a specific site.

Note

Only users who have the right to access the Sites Management drive can do it.

4.6.5.1. Create new web content

This function is used to add new web content to a specific site.

1. Go to the Sites Management drive, then select a site to which you want to add web content.

2. Select the web content folder on the left.

Note

In this step, you also can add new web content into another folders (documents

and media folders) of a site but you are recommended to select the web

content folder because:

Managing web content of a site becomes more easily.

You only may add new web content in this folder so that you do not need to

select web content document in the list of document types. It makes adding

new web content more flexibly.

3. Click  on the Action bar to open a list of content templates [46], including

Free layout web content, and Picture on head layout web content.

4. Select a template to present the web content by clicking one.

5. Enter values in the fields of the Add New Document form.

6. Click Save or Save & Close to save the content or Close to quit the Add New Document

form.

Tabs in the Add New Document form

The Main Content tab
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Table 4.27.

Field Description

Title The title of the web content.

Name The name of the web content that you want to

add new.

Language The language of the web content. At present,

eXo Platform 3.5 supports two languages:

English and French.

Main Content The main content that you want to display when

publishing this web content.

The Illustration tab allows you to upload an illustration that makes the site's content more

attractive.

Details:

Table 4.28.

Field Description

Illustration Image The path to an image that you want to upload

into a site. This image will be used like an

illustration of that site.

Summary You can give a short description about the

web content because it will be displayed with

the illustration image when the web content is

listed. The main content will be shown when it

is selected to be viewed.

Upload an image
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1. Browse a list of images on your local device by clicking the Browse... button, then select a

specific location.

2. Select an image in the list to upload.

The Advanced tab includes two parts: CSS Data and JS Data.

Details:

Table 4.29.

Field Description

CSS Data Contain the CSS definition to present data in

the web content. You can optionally enter CSS

data into this field to specify the style.

JS Data Contain the JS content to make the web

content more dynamic after being published.

You can optionally enter the JS content in this

field.

4.6.5.2. Edit web content

This function is used to edit web content in a specific drive of an existing site.

1. Go into the folder of a site which contains the web content that you want to edit.

2. Select the web content by double-clicking it in the left tree or in the right pane. The detailed

information of web content will be viewed in the right pane.

3.

Click  on the Action bar to show the form to edit the selected web content.

This form is similar to that of creating a new document.

4. Make changes on current values in the fields of this form.
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5. Complete editing the selected web content by clicking Save or Save & Close.

Note

When you click , the web content will be auto-locked for your

editing. After finishing, the content is back to the unlock status. You can manage

"Locks" in the Unlock a node [214] section.

4.6.5.3. Delete web content

This function is used to remove web content from the web content folder in a specific site's drive.

1. Right-click the name of the web content that you want to delete, then select Delete from the

drop-down menu.

2. Click OK to accept your deletion in the confirmation message.

4.6.5.4. Publish web content

This function helps you publish web content that you have added to a web content folder in Sites

Explorer.

See the Publication process section to know how to publish web content.

After the content is published, all users who have the right to access that position can view the

published web content as a page on the Navigation bar.

4.6.5.5. Preferences

This function is used to set up your browsing preferences.

1. Click  on the right side of the Sites Explorer portlet.

The Preferences window will appear.
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Details:

Table 4.30.

Field Description

Sort by Sort nodes in the nodes list by Alphabetic,

Type, Created Date, or Modified Date.

Show Sidebar Display/Hide the sidebar.

Enable Drag & Drop Enable/Disable the "drag and drop" action.

Nodes Per Page This number of nodes displayed per page.

Show Non-document Nodes Display/Hide nodes that are non–

documents.

Show Referenced Documents Display/Hide referenced documents.

Show Hidden Nodes Display/Hide hidden nodes.

Query Type This query type.

Enable DMS Structure Display/Hide document nodes in the tree

structure.

2. Configure the preferences as required and click Save to set them;

Or, click Close to quit without submitting changes.

4.6.5.6. Search in Sites Explorer

There are three ways to search for an existing node:

• Quick search.

• Advanced search.

• Search with saved queries

4.6.5.6.1. Quick search

With the quick search, you can directly type a search term in the search field. All documents, whose

keywords are matched with the search term, are retrieved and listed in the Search results form.

1. Enter a keyword into the search text box.

2. Click  to perform the search;

Or, press Enter.

The search results will be displayed in the right pane.
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The search results are empty if no document contains the search string.

3. Click  to view the content containing the keyword;

Or, click  to go to the node that contains the search result.

4.6.5.6.2. Advanced search

Perform an advanced search

1. Click  on the Filter bar.

2. Click  to open the Advanced Search form.
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The tabs in this form offer different search functions:

• Search by Name

• Search with constraints

• Search by creating a new query

• Search by existing queries

4.6.5.6.2.1. Search by Name

Use the Search by Name tab to search nodes by name as follows:

1. Enter the exact name you wish to search in the Content Name field.

2. Click Search.

Results will return with the message “No result found” if there is no node with the entered

name.

Results will be returned in the Search Results tab if the requested name is found.

4.6.5.6.2.2. Search with constraints

This search enables you to search with more constraints to limit the returned results.

Extra search constraints are entered in the Advanced Search tab of the Advanced Search form.
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The Current location field is not editable. It shows the path selected to search.

1. Enter search terms in the A word of phrase in content field.

2. Select the Operator.

• Select AND operator to only return results that meet both the search terms and the entered

constraints (see Step 3).

• Select OR operator to return results that meet either the search terms or the entered

constraints (see Step 3).

3. Click Show/Hide Constraint Form to add more constraints.

A further constraint options window will appear.

Details:

Table 4.31.

Item Description

You can add more than one constraint with

either of two operators (AND and OR).

Add a constraint to search by a property with

specific values.

Add a constraint to search by a property

that contains one of the word in the specific

string.

Add a constraint to search by a property that

does not contain the specific string.

Add a constraint to search by a duration of

date (created, modified).



Chapter 4. Basic Actions

132

Item Description

Add a constraint to search by a document

type, including File, Article, Podcast, Sample

node, File Plan, Kofax).

Add a constraint to search by categories.

Add a document type.

Add a category.

4. Select the constraint operator (AND/OR).

5. Add the required constraints using one of the following methods:

• Add a constraint for exact values [133]

• Add a constraint including or excluding values [134]

• Add a constraint by date [135]

• Add a constraint by document type [135]

• Add a constraint by category [136]

6. Click Add to add any/all activated constraints.

The constraints will be converted to an SQL query and displayed in the search form.

• Remove unnecessary constraints by clicking .

7. Click Search to launch the search. Results will be displayed in the Search Results tab.

8. Click Save and put a name for this search configuration if you want to save it to use at another

time.
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4.6.5.6.2.2.1. Methods to add the required constraints

Add a constraint for exact values

1. Tick the checkbox that corresponds to the constraint you want.

2. Enter the property you want to locate, or click  .

A list of possible properties appears.

3. Select a property from the list and click Add. The selected property will populate Property

field.

4. Define the property value to search for by entering a value into the Contain Exactly field,

or click .
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The Filter Form will appear.

All pre-existing values for your selected property will appear.

• If the value you require is in the list, select it and click Select.

• If the value you require is not in the list, enter it in the Filter field and click . The value

will populate the Contain Exactly field of the constraints form.

Add a constraint including or excluding values

1. Tick the checkbox corresponding to the Contain or Not Contain constraint, as appropriate.



Manage content in Sites Explorer

135

2. Enter the required property in the Property field, or click  (refer to Step 2 in the Add a

constraint for exact values [133] section for more information).

3. Enter the required values in the Contain or Not Contain fields.

Add a constraint by date

1. Tick the checkbox beside the field with the drop-down menu (below the Property entries).

2. Define the search condition from the drop-down list (CREATED/MODIFIED).

3. Click in the From field.

A small calendar will appear.

Select the date you want to use as a constraint.

4. Repeat the above steps for the To field.

The selected dates will populate the From and To fields in the Add constraint form.

Add a constraint by document type

1. Tick the checkbox beside the Document Type field.

2. Enter the document type you want to search, or click  to open a list of document types.
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3. Tick the checkbox corresponding to your desired document type, then click Save.

The selected document type will populate the Document Type field.

Add a constraint by category

1. Tick the checkbox beside the Category field.

2. Enter the category you want to search, or click  for a list of categories.
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3. Click  that corresponds to your desired category.

The selected category will populate the Category field.

4.6.5.6.2.3. Search by creating a new query

You need a knowledge of the structure of query statements to configure a search using the

parameters on the New Query tab.

1. Enter a unique name for this query in the Name field.

2. Select a query type from the drop-down menu: SQL or xPath.

3. Enter a query statement.

4. Click Search to perform the search and display the results in the Search Results tab;

Or, click Save to save the search query to the Saved Query tab;

Or, click Cancel to quit.

4.6.5.6.2.4. Search by existing queries

This tab lists all saved search queries that you have access rights to use.
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• Click  to perform the search. You will see results in the Search Results tab.

• Click  to edit the query statement. The query form will appear like when creating a query (see

the Search by creating a new query section); however, you cannot edit the name of the saved

search.

• Click  to delete a query (provided you have the access rights to that query).

4.6.5.6.3. Search with saved queries

Do the followings to perform a search with saved queries:

1. Click  on the sidebar to see the list of existing queries.

A query list will appear. It contains the sections, including All Articles, Created Documents,

CreatedDocumentDayBefore and allArticles.
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2. Launch, modify or delete the queries as required (see the Search by creating a new query

section for more information).

3. Filter results with the entries in the All Items and/or By Type panes on the left of the tab.

Items matching the selections will appear in the right pane.

4. Click the required document or folder name to view or download them.

4.6.6. Actions on folders and documents

This section represents actions on folders and documents through the right-click menu (Adding

to favorites, copying, cutting, pasting, adding Symlink, locking/unlocking, viewing/renaming/

downloading document, and allowing edition and copying URL to clipboard) and other actions

(dragging and dropping folders or documents).

Depending on the actions on folders or documents, the right-click menu (drop-down menu) is

different.

The actions in the right-click menu for documents:

The actions in the right-click menu for folders:
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4.6.6.1. Add to favorites

This function helps users easily add nodes (documents, folders or files) as favorite.

1. Right-click a node you want to add as a favorite.

2. Click  from the drop-down menu.

A symlink of your favorite nodes (folders, documents, files) will be created in the Favorite folder.

4.6.6.2. Copy/Paste & Cut/Paste

This function is used to make a copy of a node (including sub-nodes) to other places.

There are two ways to cut/copy & paste the node:

The first way

1. Right-click the node, then select Copy or Cut from the drop-down menu.

2. Right-click a destination node that you want to be the parent node of the copied/cut node,

then select Paste from the drop-down menu. Note that the Paste function is enabled in the

menu only after selecting the Copy/Cut action.

The copied/cut folder (and its sub-folders) will be pasted into the new selected path.

The second way

1. Right-click the node and select Copy/Cut from the drop-down menu.

2. Select the destination node that you want to be the parent node of the copied node.

3. Select the Clipboard icon on the Filter bar.
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The Clipboard window will appear.

4. Click  in the clipboard window to paste the copied/cut node into the selected destination

node in Step 3.

• You can click  to delete a specific waiting statement.

• You can also click the Clear All link to delete all waiting statements in the list.

• After the action has been taken, a confirmation message will appear with detailed information

about the destination path.

Note

You only can take the Copy action if you have this right on the source node.

You only can take the Paste action if you have the right on the destination node.

If the destination node has the same name with the copied node, after being pasted,

an index will be added to the name of the pasted node, for example Live and Live[2].

You cannot copy a content folder into a document folder.
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After taking the Copy action, you can take the Paste action on different nodes

before taking another Copy action.

4.6.6.3. Edit documents

To edit a document, refer to the Edit web content section.

4.6.6.4. Delete folders and documents

This function helps you remove folders/documents from their locations easily. Do the same steps

as in the Delete web content section.

Note

You can only take the Delete action if you have the right on a node.

If the deleted node contains sub-nodes, these sub-nodes will be deleted, too.

4.6.6.5. Drag and drop folders and documents

This function allows you to move folders/documents from a current location to another one by

using the drag and drop feature.

1. Hover your cursor over folders/documents in the right pane, or hold the Ctrl or Shift key to

select multiple folders/documents at once until the cursor changes to .

2. Press the left-mouse button and drag the selected folders/documents.

3. Drop them into another folder in either the right or left pane by releasing the left-mouse button.

The "dragged" folders/documents will be relocated to the destination folder.

4.6.6.6. Lock/Unlock folders and documents

This function is to avoid changes on specific folders/documents and actions by others, during a

specific time.

Lock folders/documents
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Just right-click a folder/document (on either the right or left window pane) and select Lock from

the drop-down menu. The selected folder/document will be locked.

Note

Only users with appropriate rights can lock folders/documents.

After being locked, other users can only view the folders/documents.

The lock will be kept as current for a session only. If the locking user signs out,

the node will be unlocked.

Other users can copy the locked node (by using the Copy/Paste functions outlined

above); however, the original node cannot be removed or altered.

If no action is taken on a locked node within 30 minutes, the lock will be

automatically removed.

Unlock folders/documents

To unlock the locked folder/document, right-click it and select Unlock from the drop-down menu.

The folder/document will then be unlocked and other users can take actions on it.

4.6.6.7. Rename folders and documents

This function is used to change the folder/document name.

1. Right-click a folder/document that you want to rename, then select Rename from the drop-

down menu.

The Rename form will appear.

2. Input a new name in the Name field. You can also change the its title by entering a new one

in the Title field.

3. Click Save to accept your changes.

4.6.6.8. Add a Symlink

A symlink embedded into a node allows you to quickly access the node even if you are in other

nodes.
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• Right-click a document that you want to add a Symlink, and select Add Symlink from the drop-

down menu.

The symlink will be added to the selected document immediately. To view its content, simply

click the symlink.

4.6.6.9. View WebDAV

WebDAV enables users to access files, folders, and read/write documents over the web. Thanks

to its benefits of easy, quick and flexible manipulations and time-saving, WebDAV is used to view

nodes.

1. Select the path of node you want to view WebDAV or open that folder from the left/right pane.

2. Right-click the node and select Download And Allow Edition from the drop-down menu.

With each type of node, the form to view in WebDAV will be different:

• Folder: The sub-nodes list of the current folder will be displayed in WebDAV.

• nt:file: The content of the document will be shown.

• Article: This node type does not, by default, list any folders. However, if the Article includes

actions, added language or other data, all folders will be listed and named; exo:actions,

exo:language and so on.

• Podcast: Being viewed in WebDAV, this node type will be attached a form which must be

completed to download this document.

• Sample Node: This node lists folder names as exo:images. Like Article, if the Sample

node contains actions or added languages, folders will be named as exo:actions,

exo:language, and more.

• File Plan: This node behaves the same way as Article and Sample Node.

• Kofax: This node behaves the same way as Article and Sample Node.

4.6.6.10. View information

eXo Platform supports you to view all information of a document, such as name, title, creator, and

publication state of the document.

• To view information of a document, right-click the document, and select View Information from

the drop-down menu.

The View Information form appears as below.
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4.6.6.11. View document

The View Document item is visible in the drop-down menu when you right-click a document. This

function allows you to view the document on another tab with the link containing the document

path.

• To view a document, right-click a document that you want to view, and select  View Document

from the drop-down menu.

The document is opened in another tab.

4.6.6.12. Copy a URL to the clipboard

The Copy URL To Clipboard enables you to copy the WebDAV URL of a selected folder or a

document. You then can view it with the WebDAV view on a browser.

1. Right-click a folder/document, and select Copy URL To Clipboard.

2. Paste the URL on another tab.

You can view the folders of the node you copied its URL or download documents to your

computer. You also view other nodes by clicking ... above the current folder to go up the root

node as below.
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4.6.6.13. Manage tags

Tags are easily managed by editing or deleting them with the Tag Manager.

Edit a tag

1. Click Tag Cloud  on the Filter bar, then click  at the upper-right corner of the tags pane.

The Edit Tag form will appear.

2. Click  that corresponds to the tag you want to edit.

3. Edit the tag to your desires.

4. Click Save to accept your changes.

Delete a tag

1. Do Step 1 [146] from the procedure above.

2. Click .

3. Click OK in the confirmation message to delete the tag.

Use your created tags



Manage content with WebDAV

147

1. Click .

You will see all existing tags which are listed and classified by private or public tags.

Depending on the popularity of tag, the display of each tag will be different from others by font-

size, font-weight, color, font-family, and text-decoration. For example, when a tag is added

to over 10 documents, it will be displayed in red color, size:20px, bold. This can also be

configured in the Manage Tag tab.

2. Each tag is similar to a link listing all documents to which it is added. To display the documents

list in the right pane, click a tag name.

4.7. Manage content with WebDAV

What is WebDAV?

WebDAV is an abbreviation of Web-based Distributed Authoring and Versioning. It is used

to publish and manage files and directories on a remote server. It also enables users to perform

these functions on a website.

WebDAV provides the following features:

Locking

This feature prevents two or more collaborators from overwriting shared files.

Site Manipulation

WebDAV supports the "copy" and "move" actions and the creation of collections (file system

directories).

Name Space Management

This function enables copying and moving webpages within a server's namespace.

Why use WebDAV?
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With WebDAV, you can manage content efficiently with the following actions:

• Copy/paste content on your device and have those changes reflected in a host-based website.

• Manipulate actions on a website easily, quickly and flexibly without accessing it directly with

web-browsers. Files can be accessed from anywhere and are stored as in local directories.

• Easily and quickly upload content to a website simply by copying it into the appropriate directory.

4.7.1. Use WebDAV in eXo Platform

To use WebDAV in eXo Platform, you first need to have the Internet or Intranet connected. Next,

you can follow one of the two following ways:

The first way

You need to connect to the WebDAV server. For example, for Windows XP, do the following steps:

1. Navigate to the My Network Places on your local device. You will see all shared files and

folders:

2. Click the Add a network place link on the left to open the Add Network Place Wizard.
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3. Click Next to select a network location:
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4. Select Choose another network location to create a shortcut.

5. Enter an address into the Internet or network address field.

For example, the address of the Acme demonstration site is http://mycompany.com:8080/

portal/rest/private/jcr/repository/collaboration/sites/content/live/acme.

6. Click Next. After a few seconds, a folder named acme on localhost appears in the My

Network Places directory.

Each site managed by WebDAV appears as a folder in this location.

7. Take actions on the content in this folder to administrate the site content remotely.

The second way

This way can be done through Sites Management.

1. Hover your cursor over  on the Administration bar, then select  Content --> Sites

Explorer  from the drop-down menu.

2. Click the Drives button, then select Sites Management.
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You will see all sites listed in the left sidebar.

3. Right-click your desired site to view with WebDAV, and select Download and Allow Edition

from the menu.

The selected site will be shown in WebDAV.

In this view, you can access documents in the directories that are linked to the web server.

4.7.2. Add new content to a specific site

This function enables you to copy web content, such as an .html file, from your local device to

a web content folder of a site.
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1. Access a site via WebDAV (refer to the Use WebDAV in eXo Platform section), then go to

a web content folder of the site.

2. Copy the web content on your local system into this folder.

The copied file will be converted to web content that is viewable by WebDAV automatically.

The content is converted to a directory containing CSS, documents, js and media.

After the new content is added, it can be viewed as a folder in WebDAV or as a page using a

web browser.

4.7.3. Delete web content

This function enables site administrators to delete web content files separately or in batches.

1. Navigate to the folder that contains the content you want to remove.

2. Right-click the content files or directories (hold the Ctrl key to select multiple files at once),

and select Delete from the drop-down menu.

The selected files will be removed from the site.

eXo Platform provides the Newsletters service, aiming at helping users quickly get the updated

newsletters from a website.

4.8.1. Newsletter viewer

Note

The Newsletter portlet is deprecated in eXo Platform. It remains fully supported for

eXo customers, however it will not receive any enhancement and will be removed

from the product scope in the future.

With Newsletters, you can instantly get newsletters from your email to update the last information

about categories and subscriptions.
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Subscribe your email to get newsletters from eXo Service.

1. Go to Newsletters on the Navigation bar. The Newsletters page will appear.

2. Enter your email address in the Your Email field.

3. Select the checkbox corresponding to the subscription that you want to get newsletters.

4. Click Subscribe. A message informing that you have just subscribed to the selected

newsletter will appear.

5. Click OK in the confirmation message. You can reselect the subscription that you want or

do not want to receive newsletters by re-selecting the checkbox in the Check to subscribe

column.

6. Click Change your subscriptions to update your changes.

7. Click Forget this email if you want to unsubscribe from newsletters.

4.8.2. Newsletter Manager

Note

The Newsletter Manager portlet is deprecated in eXo Platform. It remains fully

supported for eXo customers, however it will not receive any enhancement and

will be removed from the product scope in the future.
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eXo Platform facilitates administrators to easily and quickly manage newsletters.

To use this portlet, you first need to add it to a specific page by dragging and dropping Newsletter

Manager from Page Editor to the main pane. This can be done when creating a new page or

editing an existing page or editing the layout of a portal.

Note

In eXo Platform, the Newsletter Manager portlet is put in Page Editor -->

Applications --> Newsletter.

Access the page with the Newsletter Manager portlet to open the newsletter page.

4.8.2.1. Manage categories in Newsletter

This section shows you how to manage categories in a Newsletter page, including:

• Add a new category

• Edit a category

• Delete a category
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• Manage users

4.8.2.1.1. Add a new category

1. Click New Category on the Action bar of the Newsletter page. The Create New Category

form will appear.

Details:

Table 4.32.

Field Description

Asterisk (*) This mark next to each field means that it is

required to enter values into that field.

Name The name of a category.

Title The title of a category.

Description A brief description of the category.

Moderator Select users/groups who have rights to

manage this category.

2. Input values into fields.

i. Select a moderator for a category by clicking  next to the Moderator field to open the

User Selector form.
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• Click  corresponding to a user in the list that you want to select.

ii. Click  to select users in a specific group. The Group selector window will appear.

• Select a group from the left pane and a membership type from the right pane.

The membership and group selected will be displayed in the Moderator field.

3. Click Save to accept creating a new category.

You will see your added category in the list of categories.

• After creating a category, you can create new subscriptions or newsletters for this category.

• When clicking the Administration button, you will see a drop-down menu consisting of all

actions on this category.
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4.8.2.1.2. Edit a category

1. Select a category that you want to edit.

2. Click Administration --> Edit Category from the drop-down menu.

The Create New Category form appears.

3. Change the values in the Title and Description fields as required.

Note

The category name cannot be changed.

4. Click Save to save all changes.

4.8.2.1.3. Delete a category

1. Select a category that you want to edit.

2. Click Administration, then select Delete Category from the drop-down menu.

3. Click OK in the confirmation message to delete the category.

4.8.2.1.4. Manage users

Administrators can manage users accounts and activities with actions, such as editing, banning,

removing bans, or deleting.

1. Select a category that you want to edit.

2. Select Administration --> Manage Users from the drop-down menu.
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The Manage Users form will appear.

Details:

Table 4.33.

Field Description

Email The email address of user who has

subscribed this subscription.

Banned This field has two values:

False

The user is allowed to get email.

True

The user is not allowed to get email.

Ban this user from receiving emails.

Remove a ban on a user.

Delete the user.

3. Click Close to close the form.
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4.8.2.2. Subscriptions

Administrators can add more subscriptions to any category via two ways as follows:

The first way

1. Click New Subscription on the Action bar.

The Create New Subscription form will appear.

Details:

Table 4.34.

Field Description

Asterisk (*) This mark next to each field means that it is

required to enter values into that field.

Category The category which contains this

subscription.

Name The name of the subscription.

Title The title of the subscription.

Description The brief description about the subscription.

Redactor Select users/groups who have rights to

manage this subscription.

2. Click the Category field and select a category from the drop-down menu.

3. Enter the rest of their values in the form.

4. Click Save to create the new subscription.
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The second way

1. Click directly the category to which you want to add a new subscription.

2. Click New Subscription on the Action bar.

The Create New Subscription form pops up.

3. Do the same steps (3, 4) as stated in the first way [159].

• Administrators can create newsletters for each subscription.

• These newsletters can be opened, edited, deleted or converted to a template for reuse.

Details:

Table 4.35.

Element Description

Shoes The name of the subscription.
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Element Description

Fashion Shoes The brief description about the subscription.

Letter The list of all letters of this subscription.

Date The date and time when creating this

newsletter.

Status There are three types of status: draft, awaiting

and sent.

Moderation This button allows you to take actions on your

selected newsletter.

4.8.2.3. Open a newsletter

Administrators can easily view the content of a newsletter as follows:

1. Open the subscription containing the letter you want to open by clicking it or ticking the

corresponding checkbox, then select Administration --> Open.

2. Directly click the newsletter;

Or, select the checkbox corresponding to your desired newsletter, then click Administration

--> Open.

The View Newsletter's Content form pops up.
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3. Click Close to exit.

4.8.2.4. Edit a newsletter

1. Select the newsletter you want to edit by ticking the relevant checkbox in a specific

subscription.

2. Click , then select Edit from the drop-down menu.

The Newsletter Entry pops up.
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3. Change the values in the fields that you want to edit: Template, Send Date, Category,

Subscription.

4. Click the Update a Newsletter's info button.

5. Change values in the Title and Main Content fields.

6. Click Save to save as draft, or click Send.

4.8.2.5. Delete a newsletter

Administrator can delete obsolete newsletters in a specific subscription.

1. Select the newsletter you want to delete by ticking the corresponding checkbox.

2. Click , then select Delete from the drop-down menu.
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3. Click OK in the confirmation message to accept your deletion.

4.8.2.6. Convert as template

The administrator can reuse the template of the frequently used newsletter template.

1. Select the newsletter that you want to create as a template.

2. Click , then select Convert As Template from the drop-down menu. For the next

time when you create a newsletter, this template will be listed in the Template field in the

Newsletter Entry form.

4.8.2.7. Create a newsletter

Each subscription consists of many newsletters. In eXo Platform, you can easily create newsletters

by following these steps.

1. Select a subscription where you want to create a newsletter.

2. Click  on the Action bar to open the Newsletter Entry form.

Details:
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Table 4.36.

Field Description

Template The template for your newsletter form. Basic

Template is set by default.

Send Date The date and time to send the newsletter.

Category The category contains this newsletter.

Subscription The subscription contains this newsletter.

Update Sending Parameters This button allows you to update information

about this newsletter.

3. Click the Template field to select the template for the newsletter.

4. Click the Send Date field. The calendar will appear, allowing you to select the date and time

when you want to send the newsletter.

5. Click the Category and Subscription to select the category and the subscription in the list.

6. Click the Update Sending Parameters button to update information about this newsletter. A

message pops up and informs you that you have updated information successfully.

7. Input a title of a newsletter into the Title field.

8. Create content for a newsletter by inputting information into the Main Content textbox.

9. Click Save to save this newsletter as draft, or click Send to send this newsletter.

4.9. Manage content with Fast Content Creator

The Fast Content Creator portlet in eXo Platform enables you to quickly create and save a new

document with only one template in a specific location without accessing Sites Explorer. This

helps you save a lot of time when creating a new document.

There are two modes in Fast Content Creator: Content Creator and Standard Content Creator.
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The Standard Content Creator mode allows you to add an action to your document. When

Configuring Fast Content Creator, the Edit Mode tab has the Actions part that allows you to add

an action to the document and view actions added to the document.

To add an action to a document, click Add or  to open the Add Action form. Do the same steps

in the Add an action section.

To use the Fast Content Creator portlet, you need to add it to a specific page first by dragging

and dropping Content Creator or Standard Content Creator from Page Editor --> Applications

--> Forms to the main pane. This can be done when creating a new page or editing an existing

page or editing the layout of a portal.

4.9.1. Configure Fast Content Creator

In eXo Platform, the Fast Content Creator is applied in the Question? portlet with the Content

Creator mode by default. Thus, in this guide, you are instructed how to configure the Fast Content

Creator by editing the Question? portlet as an example.
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1. Open the Question? page.

2. Hover your cursor over Edit --> Page, then click Layout on the Administration bar.

The edit page appear.

3. Hover your cursor over the portlet, then click  to edit the portlet.

The form with the Edit Mode tab appears.

Details:

Table 4.37.

Field Description

Location to Save Select the location to save documents or

messages.

Select Template Select a template for the document. There

are different input fields corresponding to

each selected template.
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Field Description

Custom Save Button Change the label for the "Save" button.

Custom Save Message Change the content of custom message that

informs you have just saved a document.

Redirect Allow you to redirect the path in the Redirect

Path field.

Redirect Path Show a path to which you will be

directed after clicking OK in the confirmation

message.

4. Select a specific location to save documents.

i. Click  to open the Select Location form.

ii. Select the parent node in the left pane, then click  in the Add column to select the child

node in the right pane. After being selected, this location will be displayed on the Location

to Save field. Created documents will be saved in this location.

5. Select a template which is used to create a new document.

6. Change the label for the Custom Save button, and the content for Custom Save Message.

7. Tick the Redirect checkbox if you want to redirect to the path in the Redirect Path field after

clicking OK in the confirmation message.
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8. Click Save to finish the configuration of Fast Content Creator. Then, click OK in the

notification message to accept your changes.

9. Click Close to quit the form to edit the configuration of Fast Content Creator.

4.9.2. Create new content

1. Go to your newly created page.

2. Fill values in all the fields in the page.

3. Click Save to accept creating the new document. A message appears to let you know that

the document is created successfully at the location selected in the Location to Save field.

4.9.3. View content

After creating a new document by Fast Content Creator, you can view it as follows:

1. Go to Sites Explorer.

2. Select the drive and the path that you established in the configuration of Fast Content

Creator. You will see this document.

4.10. Create content templates with Form Builder

Note

The Form Builder portlet is deprecated in eXo Platform. It remains fully supported

for eXo customers, however it will not receive any enhancement and will be

removed from the product scope in the future.

The Form Builder portlet allows users to create and edit the template of document types.

Documents are stored in the so-called node; therefore, the term "node" and node types are often

applied.

To use this porlet, you need to add it to a specific page first by dragging and dropping Form

Generator Portlet from Page Editor --> Applications --> Form Generator Portlet to the main

pane. This can be done when creating a new page or editing an existing page or editing the layout

of a portal.
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Create a content template

1. Open the Form Builder portlet.

2. Enter the template name into the Name field which is required.

3. Enter a brief description about the template.

4. Click the Form Builder tab that allows you to set properties for the template. Available

components are displayed in the left pane.
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5. Click the desired components in the left pane. The selected components will be displayed

in the right pane.

6. Click  corresponding to the component to move this component up; or click  to move the

component down.

7. Click  corresponding to the component to edit properties of that component. The form to

edit properties appears like the illustration below.

Details:

Table 4.38.

Field Description

Field Label The label of the field.
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Field Description

Width The width of the field width.

If the checkbox is marked, the asterisk ( )

will appear beside the textbox, indicating that

it is required to enter values in this field.

Height The height of the field.

Default Value Display the default value.

Guidelines for User Display instructions about this component.

After editing the properties of the components, the components look like the below illustration.

• To delete the component, click  corresponding to the component.

• Click  again to hide the form to edit the properties.

8. Click Save to accept creating a new template, or Reset to edit this template again before

saving.

• A message will inform that you have created the template successfully.

• After the template has been created, you will see it in the content template list when creating

content.

4.11. Manage Category Navigation

Category Navigation and Parameterized Content List Viewer portlets get rid of long URLs

when you view content and enable users to see published documents or web content in specific

categories in one page. Thanks to the symbolic link, no matter where the object physically resides,

the database can retrieve it. In addition, the relations amongst shortcuts can be managed. Now,

you can view documents or web content in the Parameterized Content List Viewer easily.

Access the Category Navigation portlet

1. Go to News on the Navigation bar.
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• The left pane lists all the categories containing documents or web content.

• The right pane displays the documents selected in the left pane.

2. Select a category that you want to view on the left. The selected category will be shown on

the right (only documents or web content published are shown).

Configure Category Navigation

Administrators can edit the Category Navigation portlet as follows:

1. Open News page on the Navigation bar.

2. Hover your cursor over Edit --> Page --> Layout.

The page which allows you to edit the Category Navigation portlet will appear.
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3. Click  to open a form with the Edit Mode tab, allowing you to edit the portlet.

4. Click  to select the folder path which restores content you want do display.

5. Edit some fields in the Display Settings part as you want. See more details in the Content

List Preferences  [51] section.

6. Click the Advanced link to set up some properties for the portlet. See more details here.

7. Click Save to accept saving the configuration for the Category Navigation portlet.

8. Click Close to quit the form.

9. Click  on the Page Editor form to finish editing the Category Navigation portlet.

Note

In the Edit Mode tab, some options are disabled.
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4.12. Manage SEO

SEO (Search Engine Optimization) allows you to improve the visibility of your webpages and web

content in the major search engines (Google, Yahoo, MSN, Live) via the search results. The higher

your website position is in the search engine results page, the more visitors access it. Therefore, it

is very important for you to maximize your webpages and content's position in the search engines.

In eXo Platform, the SEO Management feature is featured to meet this target. By using SEO

Management, you can easily manage SEO data of web pages and web content and optimize

your website for search engines.

Manage the SEO data

1. Open a page or content that you want to edit the SEO data.

2. Open the SEO Management form by hovering your cursor over Edit --> Page --> SEO on

the Administration bar.

Depending on your SEO management for a page or content, the content of the SEO

Management form will be different.

• The SEO Management form for content is as follows.

• The SEO Management form for a page is as follows.
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Details:

Table 4.39.

Field Description

Description The description of your page/content. This

description will be seen in the results list of

search engines.

Keywords By using these keywords, other users

can find out your page/content via search

engines.

Robots Search engines can access the whole

directories on a website, or individual pages,

or individual links on a page and list your

page/content or not, it depends on your

options:

• INDEX: Allow search engines to index

your page/content on the search engine

results page.

• NOINDEX: Restrict search engines from

indexing your page/content on the search

engine results page. Use this option if you

want to keep your page private.

• FOLLOW: Allow search engines to follow

links from your page to find other pages.
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Field Description

• NOFOLLOW: Restrict search engines

from following links from your page to find

other pages. Use this option if you want to

prevent spam links in comments of blogs,

forums and others.

Sitemap Allow you to see pages of the sites in the

tree-like structure.

Frequency Show how often pages are updated on

the site. Also, setting your frequency levels

tells the search engines which pages

should be crawled over other pages. The

frequency levels include: Always, Hourly,

Daily, Weekly, Monthly, Yearly and Never.

If you set "Never" for the frequency level,

meaning that this page never gets updated,

so search engines will move onto other

pages that get updated more frequently.

Priority Allow search engines to search the page with

the higher priority level first. The acceptable

value in this field is from 0 to 1. In which, 0 is

the lowest priority level and 1 is the highest.

3. Fill out all the fields in the form.

4. Click Save to finish creating SEO data.

Note

 means that the SEO information is empty.

 means that the SEO information has been updated but some information are

not filled out yet.

 means that the SEO Management form is filled out with the full SEO

information.

 means that the SEO Management feature is disabled.

4.13. Manage content list viewer by query

The Content By Query portlet allows you to collect and display data throughout a workspace by

using a query instead of selecting items by a folder or by content.
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To use this portlet, first you need to add the Content By Query portlet to a specific page as follows:

1. Drag and drop the Content By Query portlet from the Page Editor --> Applications -->

Content to the main pane. You can do this step while creating a new page or editing an

existing page or editing the layout of a portal.

2. Edit the Content By Query portlet by hovering your cursor over it, then click  to edit the

portlet.

The form with the Edit Mode tab appears.

3. Enter a valid query into the by query field to get data that you want to display.

4. Select a workspace where you want to get data.
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5. Click Save to complete adding the Content By Query portlet.

6. Click  to quit the Page Editor page and see the displayed data.

Note

To learn more about fields in the Edit Mode tab, refer to Content List

Preferences [51].
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Advanced Actions

5.1. Manage Site Resources in one place

You can easily manage all the site resources in Content Explorer.

Chose  in General drive. All of your created sites and their resources

will be listed in the left pane.

All sites contain typical folders that are site resources:

5.1.1. CSS Folder

CSS is one of the default files of a site. This folder contains CSS data that is used to present data

in a site and increase that site's content accessibility.

CSS

Once a new CSS file is created in a site, it will affect how the site is displayed. For

example, if your new CSS file is created with the red background color, the site

background will then turn into red.
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5.1.2. Document Folder

This folder contains all documents used in a site. When you want to add a new document for a

site, you can also put them in another folder, but it is recommended to use this one to manage

everything easily and conveniently.

5.1.3. JS Folder

This is one of the default files of a site. This file contains Java Script data that is used to make

a site more animated and more dynamic.

5.1.4. Links Folder

This file contains all links used in a site.

5.1.5. Media Folder

This folder contains all documents related to videos, images and sounds. It is divided into three

sub folders:

audio:

This folder contains sound data used in a site.

images:

This folder contains images used in a site.

videos:

This folder contains videos used in a site.

5.1.6. Web Content Folders

This folder contains all web content used in sites. It is recommended to put all the web content

files here, to manage them more easily, or in case you want to reuse them in another site.
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5.2. Content Administration

This page is used to manage all workspaces, drives, node types, metadata, templates, queries,

and more. Only administrators can access the Content Administration page.

• Hover your cursor over   --> Content --> Content Administration  on the Administration

bar.

The Content Administration page will appear.
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This page enables you to access:

• Categories & Tags: Manage categories and tags.

• Content Presentation: Manage template, metadata, views, and drives.

• Content Types: Manage namespace registry, and nodetype.

• Advanced Configuration: Manage queries, scripts, and create an action type.

5.2.1. Categories and Tags

5.2.1.1. Manage tags

The Manage Tags function enables you to manage tag styles. The tag styles will change,

depending on the number of documents in a tag.

Go to Categories & Tags --> Manage Tags.

Add a tag style

1. Click the Add Style button. The Edit Tag Style Configuration form will appear.
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Details:

Table 5.1.

Field Description

Asterisk (*) This mark next to each field means that it is

required to input values.

Style Name Give the tag name which cannot be edited.

Document Range Give the number of document assigned to a

tag.

HTML Style Include font-size, font-weight, color, font-

family, and text-decoration.

2. Input values in the fields: Style Name, Document Range, and HTML Style.

3. Click Update to accept adding a new tag style.

Note

The format of valid range must be: a..b where 'a', 'b' are positive integers. You

can use * instead of 'b' to indicate it is unlimited. For example, 0..2 (means 0-2

documents assigned to a tag), 10..* (means at least 10 documents assigned to

a tag).

The 'HTML style' textbox cannot be empty. You can change values of font-size,

font–weight, color, font-family, and text-decoration.

5.2.1.1.2. Edit a tag style

The Tag Manager tab enables you to edit the existing tags.

Edit an existing tag

1. Click  corresponding to the tag name which you want to edit in the Action column to edit

the tag style configuration. The Edit Tag Style Configuration form appears which is similar

to that of adding a tag style.

2. Change values in the fields, including Document Range and HTML Style, except Style

Name.

3. Click Update to save new changes.
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5.2.1.1.3. Delete a tag style

To delete one tag style, simply click the corresponding Delete icon and select OK in the

confirmation to accept your deletion.

5.2.1.1.4. Tag Permission Manager

The Tag Permission Manager tab helps you set permissions regarding to editing and deleting

public tags.

Set Permission To Tag Management

1. Click  beside the Memberships field to select memberships to add a permission to those

memberships. The Select Membership form will appear.

2. Select a group on the left and the corresponding membership on the right. The selected

membership will appear in the Memberships field.

3. Click Save to accept adding a permission for the membership to the Memberships column.
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You can also delete memberships that have permissions by clicking  regarding to that

membership, then click OK in the confirmation message.

5.2.1.2. Manage categories

A category can be understood as a classification practice and science. It is used to sort documents,

aiming at facilitating searches. The category management includes adding, editing and deleting

a category tree.

Go to Categories & Tags --> Manage Categories.

5.2.1.3. Add a category tree

1. Click the Add Category Tree button to add a new category. The Add Category Tree form

will appear.

2. Enter the category tree name in the Name field which is required.

3. Select the workspace you want to work with.
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4. Select the home path by clicking  . The Select Home Path form will appear.

• Click  next to Root Path if you want to select the root path or;

• Click the arrow icon to go to the up level path and click the plus sign to expand the folder

in the left pane.

Click  corresponding to the path that you want to select as a home path.

5. Click Reset if you want to reset values that have just been selected or Next to select

permissions for a category tree.

i. Click  to select a user or  to select memberships or  to select everyone to set

permissions. The user or membership that you have just selected will be displayed in the

User or Group field.

ii. Check at least one of these below options to set rights for the selected user to membership:

Table 5.2.

Field Description

Read Right Select the Read right or not.
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Field Description

Add Note Right Select the Add Node right or not.

Set Property Right Select the Set Property right or not.

Remove Right Select the Remove right or not.

6. Click Save to save all values, or Reset to change values that have just been set. After clicking

Save, click Next to go to the next step.

7. Enter the name for an action of the category tree in the Name field which is required.

8. Select values for Lifecycle, Node Types, Target Workspace, Target Path, Affected Node

Types  which are required.

9. Click Save to save all values, then select Next to go to the next step.

Note

Do not input some special characters into the Name field, such as: !,@,#,$,%,&,*,

(,).

Do not add a category which has the same name and level with existing taxonomies

in a node.

The category name must contain less than 30 characters.

5.2.1.4. Edit a category tree

1. Click  corresponding to the category tree you want to edit.
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2.
Click  in the Add column to add more category trees. The Edit Category Tree form will

appear.

3. Enter a category name in the Category Name field which is required.

4. Click Save to save the category name.

5. Click Previous to return to the previous steps.

6. Click Save to save all changes, or Previous or Next if you want to edit more.

Note

You can delete a category by clicking  corresponding to the category that you

want to delete. Click OK in the confirmation message to accept your deletion.

You cannot delete categories that have been referenced.

5.2.2. Content Presentation

5.2.2.1. Manage a template

When creating a node in eXo Platform, you must set its properties. Thus, each node needs to

have a form to enter data for their properties (called the Dialog template), and display the existing

values (called the View template). The template management allows users to view, delete and

modify the predefined templates or to add a new template.
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Add a new template

1. Click Content Presentation --> Manage Templates.

2. Click the Add button in the Manage Templates form to open the Template Form.

3. Select the template type from the Name drop-down menu.

4. Specify a name for the template in the Label field. It is required.

5. Select the is Document Template checkbox if you want your created template to become

a template for a document.

6. Click  next to the Permission field to open the Select Permission dialog. It is required.

• Select the group from the left pane and the membership from the right pane;

•
Or, you can set permissions for everyone by clicking  next to Any Permission.



Chapter 5. Advanced Actions

192

7. Optionally, select the Dialog tab and enter the value in the Dialog Content field.

8. Optionally, select the View tab and enter the value in the View Content field.

9. Optionally, select the CSS tab and enter the value in the CSS Content field.

10. Click Save to create the template.

Edit a template

1. Click Content Presentation --> Manage Templates.

2. Click  in the Action column, corresponding to the template you want to edit.

3. Make changes on the values of each tab, including:

• In the Template tab, you can edit the label of the template.

• In the Dialog tab, you can do the followings:

Add a dialog

i. Input content for this dialog in the Content field.

ii. Input the name for this dialog that is required.

iii. Select permissions for a group that can use this dialog that is required.

Edit an existing dialog

i. Click  in the dialog row you want to edit.

ii. Edit the dialog properties.

iii. Click Save to accept all changes in the Dialog tab.
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Delete an existing dialog

i. Click  in the dialog row you want to edit.

ii. Click OK to accept your deletion.

Note

You cannot delete the default dialog. You must create a new one before you

can delete the current default dialog.

• In the View tab, you can do the followings:

Add a view

i. Enter content into the Content field.

ii. Input name for this view that is required.

iii. Select permissions for a group that can use this view that is required.

Edit an existing view

i. Click  in the Actions column, corresponding to the view you want to edit.

ii. Edit the view properties.

iii. Click Save to accept all changes in the View tab.

Note

You cannot change the view name.

If you click is Enable Version checkbox, this view automatically increments

one version after you have clicked Save. It is displayed at Version column

in the View tab.

If the dialog has at least two versions, in the View tab, it displays the Restore

button. You can use Restore to roll back to the previous View.

Delete an existing view
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i. Click  in the Actions column, corresponding to the view you want to delete.

ii. Click OK to accept your deletion.

iii. Click Save to accept all changes.

Delete a template

1. Click  corresponding to the template you want to remove in the Manage Templates page.

2. Click OK in the confirmation message to accept your deletion.

5.2.2.2. Manage metadata

Metadata is generally defined as "data about data". Metadata is information which describes,

or supplements the central data. In the Manage Metadata tab, you can manage nodes in the

metadata format in the eXo Platform system. The metadata may be considered as information

used to describe the data. When data are provided to end-users, the metadata allows users to

understand about information in more details. All metadata nodes can combine with other nodes

to create a new node (add mix).

View metadata

1. Click Content Presentation --> Manage Metadata.

2. Click  corresponding to the metadata you want to view.

The Metadata Information form will open.
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Edit metadata

1. Click  in the Template's Actions column, corresponding to the metadata you want to edit.

The Edit Metadata's Template form will open.

2. Change the required properties of the metadata.

Note

You cannot edit the metadata name.

3. Click Apply to save all metadata changes.

Delete metadata

1. Click  corresponding to the metadata you want to delete.

2. Click OK in the confirmation message to accept your deletion.

5.2.2.3. Manage views

The Manage View function is used to control view ways of a user. It has two tabs: View and

ECM Templates
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To open the Manage View function, click Content Presentation --> Manage View. The Manage

View form displays.

5.2.2.3.1. Views tab

In this tab, you can add, edit, delete, and preview views.

Add a view

1. Click the Add View button located at the bottom of the Manage View form.

The Add View form will open.

2. Specify the view name in the Name field that must be unique, and only contains standard

alphanumeric characters. It is required.

3. Set permissions for the view by clicking the plus icon. It is required.
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•
Click  next to Any Permission to assign permission to every one;

• Or, select a group from the left pane and the membership from the right pane.

4. Click the Templates field and select a template from the drop-down menu for this view.

5. Click the Add Tab button to create a functional tab on this view. It is required.

i. Enter the name for the tab in the Name field.

ii. Specify functions to add to the tab.

iii. Click Save to finish creating a tab;

Or, click Reset to clear the Tab form;

Or, click Back to return to the View Form tab of the Add View form.

The newly created tab is displayed on the Tabs field.
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6. Click Save to apply all settings and close the form.

Edit a View

1. Click  in the Action column, corresponding to the view you want to edit.

2. Edit the view properties.

Note

You cannot change the view name.

If you select the Enable Version checkbox, this view automatically increases

to one version after you click  Save. It is displayed at the Base Version column

in the View tab.

If the dialog has at least two versions, in the View tab, it displays the Restore

button. You can use Restore to roll back to the previous View.

3. Optionally, click the Add Tab button to open the Tab Form tab that allows you to add more

Tabs to the View.

4. Optionally, click an added Tab to add or remove functions on it. Note that you cannot change

the tab name.

5. Click Save to apply all changes in the View tab.
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Delete a view

1. Click  corresponding to the view you want to delete in the Manage View page.

2. Click OK to delete the view in the confirmation message.

Note

You cannot delete a view which is in use.

Preview a view

1. Click  in the Action column of the view you want to preview.

The View form will open.

2. Click Close to exit the View form.

5.2.2.3.2. ECM Templates tab

Add a new ECM Template

1. Select the ECM Templates tab.
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2. Click the Add button to open the Add ECM Template form.

3. Input the content of the template in the Content field.

4. Input a name for the template in the Name field.

5. Select a type for the template in the Template Type field.

6. Click Save to accept adding a new template.

Edit a template

1. Click  next to the template you want to edit.

2. Change the current template's properties.
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3. Click Save to accept all changes.

Note

You cannot edit the template name.

If you tick the Enable Version checkbox, this template will automatically

increase to 1 version after you have clicked Save. It is displayed at the Base

Version column in the ECMS Template tab.

If the template has at least two versions, in the Edit ECM Template form, it

displays the Restore button that allows restoring the template version.

Delete a template

1. Click  corresponding with the template you want to delete.

2. Click OK in the confirmation message to accept your deletion.

5.2.2.4. Manage drives

The function supports you to manage drives in the Sites Explorer. It allows adding, editing and

deleting drives.

Go to Content Presentation --> Manage Drives.

5.2.2.4.1. Add a new drive

1. Click the Add Drive button in the Manage Drives page to open the Add Drive form.
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2. Input a name for the new drive in the Name field that is required.

3. Select a workspace for the drive from the drop-down menu by clicking the Workspace entry.

4. Select the home path for the drive by clicking  beside the Home Path entry.

5. Browse an icon for the workspace by clicking  beside the Workspace Icon entry.

Select an icon by clicking  corresponding to your desired icon file.
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6. Select permissions for groups that have access rights to this drive by clicking  beside the

Permissions entry.

7. Select or deselect the various checkboxes to hide or show the drive elements respectively.

Show Referenced Document

Allow viewing preference documents.

Show Non-document Nodes

Allow viewing non-documents.

Show Sidebar

Allow showing the sidebar.

Show Hidden Node

Allow showing the hidden nodes.

8. Select the document type that will be created in this drive.

9. Select the Apply Views tab and select the view types you want to be available in the drive.
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10. Click Save to complete creating the new drive, or Refresh to clear the form.

5.2.2.4.2. Edit a drive

1. Click  corresponding to the drive you want to edit. The Edit Drive form will appear.

2. Edit the properties as required.

3. Click Save to commit the changes.
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Note

The drive name cannot be edited in this form.

5.2.2.4.3. Delete a drive

1. Click  that corresponds to the drive you want to delete.

2. Click OK to delete the drive in the confirmation message.

5.2.3. Content Types

5.2.3.1. Namespace registry

The namespace is a prefix in the node type name. It enables you to create node types without

fearing any conflict with existing node types. The registry helps you manage the namespaces

used in the system.

Select Content Types --> Namespace Registry to open the Namespace Registry form.

Register a namespace

1. Click the Register button on the Namespace Registry form to register a new namespace.

2. Enter the value for the Namespace Prefix field that is required.

3. Enter the value for the URI field which must be unique and required.
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Note

The namespace must not contain special characters, such as !,@,#,$,%,&,*,

(,).

5.2.3.2. Manage node types

This function is used to control all node types in eXo Platform.

View node types

1. Click  that corresponds to the node you want to view. The View Node Type Information

form will appear.

2. Click Close to exit this form.

Add a node type
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1. Open the Add/Edit Node Type Definitions form by clicking the Add button on the Manage

Node Type page.

2. Select a namespace for the node.

3. Enter a name in the Node Type Name field. This field is mandatory and its value must be

unique.

Note

The name must not contain special characters, such as !,@,#,$,%,&,*,(,).

4. Select a value for the Is Mixin Type field.

• True: This node is Mixin type.

• False: This node is not Mixin type.

5. Select a value for the Orderable Child Nodes field.

• True: Child nodes are ordered.

• False: Child nodes are not ordered.

6. Enter a value for the Primary Item Name field.

7. Click  to add more parent types in the Super Types field.

• Property Definitions: List all definition names of the Property tab.

• Child Node Definitions: List all definition names of the Child Node tab.

8. Click Save to accept adding a new node type, or Save as Draft to save this node type as draft.

Export Node Types
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1. Open the Export Node Types form by clicking the Export button at the bottom of the Manage

Node Type page.

2. Click Uncheck all if you do not want to export all node types. After clicking Uncheck all, this

button becomes the Check all button.

3. Select nodes that you want to export by ticking the checkboxes.

4. Click the Export button in this form.

5. Select the location in your device to save the exported node.

Note

You must select at least 1 node type to be exported. If you do not want to

export the node, click Cancel to quit this pop-up.

Import Node Types

1. Open the Import Node Type From XML File form by clicking the Import button at the bottom

of the Manage Node Type page.
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2. Click the Browse... button to upload a file.

Note

You must upload an XML file. This file is in the node type's format.

3. Click the Upload button.

Note

If you want to upload another file, click  to delete the file which has just been

uploaded, then upload other files.

4. Tick the checkboxes corresponding to the nodes that you want to import.

5. Click the Import button to complete importing a node type.

5.2.4. Advanced Configuration

5.2.4.1. Manage queries

The function enables you to manage queries. It allows adding, editing and deleting queries.

Go to  Advanced Configuration --> Manage Queries.

Add a new query

1. Open the Add Query form by clicking the Add Query button in the Manage Queries page.
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2. Enter a query name into the Query Name field.

3. Select the query type from the drop-down Query Type menu.

• xPath (XML Path Language) is a language for selecting nodes. For example, /jcr:root/

Documents/Live.

• SQL (Structured Query Language) is a database computer language.

4. Enter the statement for the query that must be unique.

5. Check or uncheck the Enable Cache Results option. If you tick this checkbox, for the first

time you use this query to search, the result will be cached. For the second time you search

using this query, it will show the cached results. After 45 minutes, the cache will be removed.

For example, you have the query Test with statement //element (*, nt:file). In the File

Explorer, you have a nt:file document named File1. When you execute the query Test,

only document File1 will be shown. After that, create a nt:file document named File2

and execute query Test, only document File2 document will be listed. After 45 minutes, the

cache will be removed. When you execute the query Test, the documents File1 and File2

will be listed.

6. Select permissions for a group that can use this query by clicking .

7. Click Save to finish adding a new query.

Edit a query

1. Click  corresponding to the query you want to edit. The Edit Query form will appear.
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2. Edit the properties of the selected query.

3. Click Save to accept all changes.

Delete a query

1. Click  corresponding to the query you want to delete.

2. Click OK in the confirmation message to accept your deletion, or Cancel to discard this action.

5.2.4.2. Manage Scripts

The function enables users to manage all script codes in the eXo Platform and Browser Content

system.

Go to Advanced Configuration --> Manage Scripts.

Add a new script in ECM

1. Click the Add button in the Manage Script page to open the Add/Edit Script form.
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2. Enter a value for the Script Content field.

3. Enter a script name for the Script Name field that must be unique and not contain special

characters, such as !,@,#,$,%,&,*,(,).

4. Click Save to accept adding the new script.

Edit an ECM script

1. Click  corresponding to the script that you want to edit in the ECM Scripts tab. The Add/

Edit script form will appear.
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2. Edit the properties in this form.

3. Click Save to save all changes.

Delete an ECM script

1. Click  on the script that you want to delete in the ECM Scripts tab.

2. Click OK in the confirmation message to accept your deletion, or Cancel to discard this action.

5.2.4.3. Create an action type

This function allows you to manage all action nodes in the eXo Platform.

1. Select Advanced Configuration --> Create Action Type.

2. Click the Add button to open the Action Type form.

3. Select the action type.

4. Input a name for the action.

5. Check/uncheck the is Action Move option. The action will have exo:move property or not.
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6. Select an "execute" for the Execute field.

7.
Click  next to Variables field to add more values for the action.

• Click  to delete a value.

8. Click Save to accept adding a new action type.

5.2.4.4. Manage locks

All locked nodes are listed and managed by administrators in the Content Administration page.

There are two ways that help administrators lock nodes: unlock nodes in the right-click menu in

Sites Explorer or unlock nodes in the Content Administration page.

Unlock a node

1. Select Advanced Configuration --> Manage Locks on the Manage ECM Main Functions

pane on the left. The locked nodes will be listed in the right pane.

2. Click  corresponding to nodes which need to be unlocked in the Locked Node tab in the

right pane. The unlocked nodes will disappear from the locked nodes list.

Administrators can manage and add the unlock permission for another group and users in

the Manage Lock tab.

3. Select the group on the Select Group pane and the corresponding membership on the Select

Membership pane. The selected group will be listed in the Groups Or Users column.

•
Click  to allow any users to unlock nodes.
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• Click  corresponding to the group which you want to remove form the "Unlock" permission

list, except the group *:/platform/administrator and root.
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Next Steps
This user guide has provided a thorough explanation of features and terminologies within eXo

Platform. Now that you know how to create, manage and publish web content and administer

a website based on eXo Platform, you may have more questions or want to get involved. The

following links can connect you with resources to learn more and contribute to the open source

development process.

• Learn more about eXo Platform 3.0 [http://www.exoplatform.com/company/public/website/

platform]

• Video demos, tutorial and more in the eXo Resource Center [http://www.exoplatform.com/

company/public/website/resource-center]

• Access another eXo documents in the eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/

Main/WebHome/]

• Ask question about eXo Content in the Forum [http://forums.exoplatform.org/portal/public/

classic/forum]

http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://forums.exoplatform.org/portal/public/classic/forum
http://forums.exoplatform.org/portal/public/classic/forum
http://forums.exoplatform.org/portal/public/classic/forum
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Appendix A. Revision History
Revision History

Revision 1-2.3 Wed Dec 15 2010 ScottMumford<smumford@redhat.com>

Exported company-specific content to separate files.

Revision 1-2.1.1 Fri Nov 19 2010 ScottMumford<smumford@redhat.com>

Updated docbook source to WCM 2.1.1

Revision 1-2.0 Mon Oct 25 2010 ScottMumford<smumford@redhat.com>,

LauraBailey, TomWells,

EslpethThorne,

RebeccaNewton, JaredMorgan

Completed docbook conversion.

Revision 1-0 Tue Sep 28 2010 ScottMumford<smumford@redhat.com>

Initial creation of book by publican
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